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The Federal Election Commission is pleased to provide you with the
latest version of FECFile,  the record keeping and electronic filing
software designed specifically for creating and submitting electronic
financial disclosure reports.  The Commission’s ongoing effort to sim-
plify, streamline and improve federal campaign finance reporting has
resulted in electronic filing software that is fast,  intuitive and less time
consuming than the old paper reporting system, and it offers many other
advantages as well. The Commission has created FECFile for users who
wish to file electronically but do not have other software packages that
will allow electronic filing.  Strictly designed as a tool for reporting FEC
financial disclosure information,  FECFile performs only those tasks

directly related to filing and  does not support unrelated functions such as bank reconciliation or
contact management. Since its release in 1997, the program has been successfully employed by
many committees of all sizes and types to file their FEC reports.  For those requiring broader
functionality or integrated software systems, the Commission has worked with commercial
software vendors to incorporate electronic filing capability into their government relations and
campaign management software packages. Because this is a user manual for FECFile specifi-
cally, we will discuss the highlights of electronic filing and the functionality of FECFile only.

Rules and Regulations

It is the purpose of this manual to instruct the user in the data entry and uploading procedures
required to create and file and electronic report with the FEC.  While some short definitions of
transactions are included for clarity, official and more detailed information regarding the rules and
regulations of FEC financial disclosure is available in the Campaign Guides published by the FEC.
These may be obtained in print form from the FEC or in PDF form from the FEC website http://
www.fec.gov. If you are unsure as to the reporting requirements for a particular transaction, please
check the appropriate campaign guide. If further information is necessary, call the FEC Informa-
tion Division at 800-424-9530 (press 1) or 202-694-1100.

Who can use FECFile?

Any non presidential committee required to file federal campaign finance reports is welcome to
use FECFile.  Because Senate committees are required to file with the Secretary of the Senate
rather than the FEC, and the Senate does not accept electronically filed reports, Senate cam-
paigns must submit their official filings on paper and cannot use FECFile to file official elec-
tronic reports. The FEC has created an unofficial web site where Senate committees may display
their information on the Internet if they so desire.  If you are interested, please contact the FEC’s
Electronic Filing Office to receive more information about submitting an unofficial electronic
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filing with the FEC.

FECFile is distributed solely by the Federal Election Commission and is available free of charge. It
may be downloaded from the FEC website, www.fec.gov, or call 1-800-424-9530 to receive a copy
by mail.

Forms and Schedules

The forms and schedules included in this program:

� Form 3 (House and Senate candidate committees)

� Form 3X (PACs and Parties)

� Schedules A through H4

� Form 6 (48 hour notices)

The software supports all types of special transactions such as In-Kind, Earmarked and Partner-
ship receipts and credit card payments.

Benefits of Using FECFile

�  automatic aggregation of line items as well as entity year-to-date totals

�  automatic itemization tracking

�  contains a database of all basic candidate and committee information

�  24x7 tech support

�  displays information in an FEC form that you can preview or print

�  alerts the user and/or eliminates some common reporting mistakes (i.e. missing information)

�  generates 48-hour reports

�  stores name and address of contributors

�  generates amended reports with ease

�  centralized electronic storage of FEC reports

Benefits of Filing Electronically

� instant confirmation emailed and/or faxed from the FEC

� improved data handling (your data in the permanent record comes directly from you)

� structural validation (Checks the necessary fields for data)
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� prior approval of forms is not necessary - there are no “forms” in an electronic filing

� encryption technology guarantees file integrity

Passwords

Passwords replace the official signature on electronically filed FEC reports.  “Electroni-
cally filed” in this case means filed through direct dial (modem to modem) or over the
Internet.  FECFile, as well as other FEC-compatible, electronic filing software pack-
ages, utilize your unique password and the FEC committee ID number to encrypt and
sign your electronic filing, thus ensuring that the filing originated from the actual
treasurer or assistant treasurer of the filing committee. You must have a password in
order to file electronically.

Only the official treasurer and assistant treasurer are permitted to obtain an electronic filing
password. The process is simple. Just mail or fax a password request to the FEC electronic filing
office. The request must be on official committee letterhead and include the committee name,
committee ID number (e.g. C00123456) treasurer and/or assistant treasurer’s name, phone
number and signature. See appendix I for Contact information and a sample password request
letter.

About this Manual

This manual uses symbols designed to inform the reader as to the importance of the content. These
symbols appear in the left margin and indicate the following:

 The reader should not proceed without reading and understanding text marked with a
stop sign. It indicates steps that must be completed prior to continuing.

Text marked with this sign should be read carefully. It indicates a course that should be
followed with caution.

This indicates a process which is not easily reversed. Think before proceeding.

This indicates important information.



Chapter 1 Page 9

Concepts and Terms

Within this manual you will notice certain terms and concepts that must be understood in order
to make the most of the information provided. For those who are frequent computer users, these
may be entirely familiar, but, for others, a brief definition might prove helpful.

General Computer Terms

Cascade - To arrange open windows one behind the other.

Click - Position the mouse pointer in the desired position and click once with the left mouse button.

Double Click - Position the mouse pointer in the desired position and click twice in rapid succes-
sion with the left mouse button.

Grayed Out - This is the term for an item on a screen that is lighter in color than other items and can
be seen but not accessed. This is usually because it is not required in a particular situation though in
other circumstances it may be available.

Right Click - Position the mouse pointer in the desired position and click once with the right mouse
button.

Tile - To arrange open windows side by side or one above the other.

FECFile-Specific Terms

Clone - To create a new transaction by making a copy of an existing one. This can be used to
streamline data entry for repeat contributors.

Endorsement tab - Transactions that require related memo entries use the endorsements tab to
relate the original transaction to the memo transactions.

Special tab - Some entries into the software require special information and it is entered on the
special tab. Examples would be campaign committees that require office, state and district or Joint
activities that require and event date.

Upload - The process of filing a report electronically

Validate - Validating a filing checks it for errors that would make it unacceptable to the FEC
electronic filing system.

View - A View is a screen that displays a certain type of data. For instance the Receipt View
displays all receipts, the Summary page View displays the totals for the summary page.
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Contact Information

Toll Free FEC Number - 800-424-9530

Electronic Filing Office - 202 -694-1293

Technical Support - 818-889-2000

Email - electronic@fec.gov

Web Site - www.fec.gov

Federal Election Commission

999 E Street N.W.

Washington, DC 20463

Review - Chapter 1

1 Refer to the Campaign Guides for official information regarding the rules and regulations.

2    Presidential committees cannot use FECFile 3.

3    Senate committees can use the software but cannot file electronically.

4    You cannot file electronically without a password!
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Before you can start creating reports and filing electronically with
FECFile, you must install the software on your computer.  Installation
and setup of your committee using the FECFile setup program are simple
and quick, but prior to installation, be sure to check your system to see
if it meets the minimum requirements listed below.

System requirements

� 8 megabytes of RAM

� Microsoft Windows 95, 98 or NT 4

� 3.5 High Density Floppy Diskette Drive

� Modem or Network Internet Connection (To file electronically)

Installation procedures

From diskette

1. Close any open applications on your computer.

2. Insert the disk labeled Disk 1 of 3 into drive A or drive B.

3. From the Start menu, select Run and then type A:\setup or B:\setup (depending on the
drive you are using) in the command-line box, and click OK.

From download

1. Download fecfile from http://imgsrv.sdrdc.com/cgi-bin/fecfile

2. Save file to hard drive.

3. Double click on the setup.exe file.

Both methods

4. Follow the instructions provided during the setup process. Do not install on a network
drive.

5. When the installation is complete the screen will display “FECFile3 Setup is complete
and your software is now installed”.

C
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FECFile Installation and Setup2
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Starting the program for the first time

If you accepted the defaults during the installation process, you will find a separate Start menu,
Program item called FECFile3.  This folder will contain shortcuts to:

CSV2DCf Starts a FECFile data import utility program.

CSV2DCf Help Starts an importing Help file.

FECFile Starts FECFile.

FECFile Help Starts the Help file for FECFile.

Remove FECFile3 Starts the Uninstall program.

Opening FECFile

1. Go to the Start menu, then select the Program item FECFile3.

2. After selecting the FECFile3 folder, select the application FECFile.

3. FECFile should now be open.

4. If you did not accept the installation defaults, open the application, FECFile.exe, from
the folder where it was installed.

Setting up your committee/creating your file

When FECFile is open, select New from the File menu.  You will be asked a series of questions
in order to determine the Form set (3 or 3X) you need.  When prompted, answer the following
questions:

1. Type of new filer - It is important to answer this question correctly; your answer will
determine the FEC form that will be used.  The options for committee type: Campaign
Committee, Political Action Committee, Political Party Organization, Other (Political) Com-
mittee, or Candidate.  Highlight the committee type by selecting it with your mouse; then
click OK.

If you are uncertain about your committee type, check your most recent Statement of Organi-
zation (FEC Form 1).  If you cannot determine your committee type, please contact the
Information Division of the FEC at (202) 694-1100.  (If you are completing a report for a
candidate campaign committee, you should select “Campaign Committee” rather than “Can-
didate” because the committee actually files the report.)



Chapter 2 Page 13

2. Individual/Organization
information - This next step will
add your committee’s basic in-
formation into your file.  Click
on the Details tab (fig. 1.)  Enter
the committee’s name, FEC ID
number and address.  (Shortcut -
You may use the Lookup feature
to automatically fill in the needed
information.  Please refer to the
section Using the Lookup feature
in chapter 3.)

If you are setting up a candidate
campaign committee, click on
the Special tab.  Enter the office,
state, district and name of autho-
rized candidate in the appropri-
ate fields.  If you used the
Lookup feature, the information
fills the fields automatically from the FEC’s databases.

3. If yours is an authorized
committee, you have one extra
step.  Choose the Special tab (fig.
2) and right-click in the Autho-
rizing Candidate field. This pro-
cess will enable you to create a
record for the candidate as a
separate entity.  Select Candi-
date from the Type tab.  Click
on the Details tab and enter the
candidate’s information.  Click
OK.  This will return you to the
Individual/Organization infor-
mation screen for the committee,
and  the authorizing candidate
will now be associated. Select
OK.  A message will appear ask-
ing if you want to replace this
object; select  Yes.

fig. 1

fig. 2
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4. Type of new report -
On this screen (fig. 3) you
will select an FEC report .
The reports are named for

the due date (for example,
April 15 Quarterly is due on
April 15th).  It is important
here to choose the correct re-
port type because this infor-
mation can not be edited.  If
you are starting FECFile at
the beginning of the year:
Quarterly filers should create
an April 15 Quarterly or a
July 31 Mid-Year, depending
on whether the year is an elec-
tion year or a non election
year. Monthly filers create a
February 20 Monthly report.
If it is not the beginning of the
year but you have not yet filed
any reports with the FEC, please choose the report type that represents your next filing.

Monthly reports are named for the month they cover! A June Monthly report covers
May 1 through May 31! Choosing the incorrect report and coverage dates could re-
sult in the need to file an amendment.

If you are starting to use FECFile after the first filing period of the year, STOP and read
the section in this chapter on adjusting aggregate totals. If you have electronic data for the
information that was already filed with the FEC in the current reporting year, STOP and
read about importing in chapter 8.  If you have outstanding loan or debt balances from
prior years, STOP and read the section in this chapter on Obligations from prior years. If
any of these situations apply to your committee, please be sure to read the appropriate
section before you choose your report type.

5. After you select your report type, the Details tab will open.  Enter the report’s coverage
dates in the From and To boxes.  FECFile does not know if the dates you entered are correct.
However, it does check to see whether the dates are actual dates (for example, it will reject 2/
31), and it checks to be sure you are not missing dates (for example, if your last report covered
1/1 through 3/31, it will not let you start your next report on 4/3.)  You can enter dates by using
any of the following formulas: m/d (1/1), mm/dd (01/01), mm/dd/yy (01/01/00) and mm/dd/
yyyy (01/01/2000).

6. If applicable, enter the election state and date on the Details tab of the Report Informa-

fig. 3
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tion box.  These fields are
only available when the re-
port requires election infor-
mation (for example, 12-day
PrePrimary).

7. On the Details tab,
set the Treasurer’s (or Assis-
tant Treasurer’s) name in the
Signed by field.  Right-click
in the field. This will take
you again to the Individual/
Organization Information
View.  From the Type tab, se-
lect the appropriate entity
type for your committee’s
Treasurer (for most commit-
tees, this will be “Individual
other than a candidate” or it
will be “Candidate”.)  Click
on the Details tab (fig. 4) and fill in the necessary information.  Click OK. This will return you
to the Report Information Details tab.  The Treasurer’s name will appear on the FEC report’s
Summary Page, in the box labeled “Type or Print Name of Treasurer”.  The address informa-
tion entered will only appear if the Treasurer also has qualifying transactions that must be
reported to the FEC (for example, the Treasurer donates $200.01 to the committee).

8. The Special tab has check boxes for reporting a new committee address, multi-candi-
date status (Form 3X users only) and election activity (Form 3 users only).  Click on the box
next to the text if any of these check boxes are applicable. (If they are not applicable, you can
skip this tab.)  Click OK.  Click Yes to replace this object.

Naming Your File

Go to the File Menu and select Save As.  You can name your file anything you want in the File
Name field (type the name in that field).  It is best to use something you will remember such as the
organization’s name.  All of your reports will be kept in this one file (i.e. Mid Year and Year End
reports will be created in  this file).  The file type will default to Electronic Filings (*.dcf).  This is
the file extension that can be read by FECFile. Please accept the default.  Click on Save.  Your file
will be saved in the FECFile directory on the drive where you installed the program.  If you accept
the defaults, the file will save in C:\FECFile3.

Adjusting Year-to-Date Aggregates

If you are starting to use FECFile with your first FEC report of the calendar year (coverage
date beginning Jan 1) and you have no prior debts, this section does not apply to you.

fig. 4
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NOTE: This section does not include detailed data entry instructions. Refer to the detailed infor-
mation in chapters 3 and 4 before actually entering data.

 If you are beginning to use FECFile, and have previously reported transactions to the FEC this
year, you will need to adjust your aggregate totals to bring the opening cash balance and entity
year-to-date figures up to date.  In other words, financial activity for the current year must be
entered into FECFile so the software can properly track your totals.

Example: You work for a committee that files monthly.  One of your contributor’s, Anita

Job,  gave your committee $150.00 on 1/18/99.  This contribution was accounted for in your
February 20 report to the FEC.  Anita gave an additional $75 on 2/12/99. This must be ac-
counted for in your March 20 report to the FEC.  You began using FECFile to report your April
20 report. Your column B information on the detailed summary must include Anita’s $225
contribution and, if she gave again in March, her aggregate year-to-date amount must include
the previous transactions as well.

There are three different methods that can be used to adjust your committee’s totals: importing, full
entry and lump sum entry.   All three require that you create a report with coverage dates beginning
Jan. 1 and ending the last day of your previous reporting period. If, for example, your next report is
due on January 31 and covers Oct 1 through Dec 31, you would create a report covering Jan 1
through Sept. 30. The purpose of this report is to contain transactions from all previous reports in
the current year so that your calendar-to-date totals and individual aggregates will be correct. It is
not to be submitted to the FEC. See Chapter 4, Building a Report, for step-by-step instructions.

NOTE: Once you have created more than one report, it becomes important to make certain you
have selected the correct report during data entry. The program will not allow transactions to be
entered into a report if they are outside the coverage dates for the report. If you attempt to enter a
transaction and find that the date of the transaction is not allowed, go to Reports on the View menu
and click on the correct report for the transaction.

� Importing - if you previously maintained your records in an electronic form, you might
be able to import the data into FECFile.  Please refer to Chapter 8 - Importing.

� Full entry -The recommended method where practical. Every transaction from ev-
ery report filed this year with the FEC is entered into the program.  Using the example above,
you would create a report covering January (report type February 20th) and enter the contribu-
tion from Anita for $150.00 on 1/18/99.  Create a March 20th report for the $75 contribution.
This is the recommended method if it is feasible for the committee.  You will be learning how
to use FECFile while recreating your old reports.  The software will have an accurate history of
your committee’s activity for the calendar year.  If you have the time now, this method will save
you time on your next report.

����� Lump Sum entry - If you have numerous transactions, which are not stored in an
electronic form, and the thought of entering them all is overwhelming, you can enter lump
sums.  However, please remember using this method means you cannot create amendments
from FECFile for the reports where you entered lump sums.
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For all following lump-sum examples: You just began to use FECFile, you are a
Quarterly filer and it is Oct 12 of an election year (this means you file 4 quarterly reports covering
the calendar year).   Your next report is the Year-end report due January 31.

Example:

� Janet Rankin just donated $200 to your committee.

� In the first quarter Janet donated $100.

� She gave nothing in the second quarter.

� She gave $300 in the third quarter.

This means Janet needs to have an aggregate year-to-date total of $600 in the fourth quarter report.
FECFile does not know that Janet previously donated $400 since those transactions were not en-
tered into the program.

Procedure:

� Create a  report covering  1/1 through 9/30 (the coverage dates of the 1st Quarter, 2nd

Quarter and 3rd Quarter).  This report will contain all of the financial activity for the
previously reported information.

� Enter an individual contribution from Janet Rankin for $400.00 on 9/30.  The date is
arbitrary but it must be prior to the current period and within the current year.

The report covering 1/1 though 9/30 is for adjusting your aggregates only.  It should never be
submitted to the FEC.  Now when you enter the $200 contribution in the fourth-quarter report that
you are preparing to submit to the FEC, Janet will have a year-to-date total of $600.

With regard to operating expenditures, while, in most cases, you are not required to report calendar-
to-date amounts, you still must track the total amount per vendor for itemization threshold pur-
poses. They can be treated the same way as the receipts in the previous example. Next to complete
data entry, this is  the best approach.

Example:

� You previously reported spending $780 at the Office Supply Store, $900 at
the US Postal Service, $22 at the mug shop and $1000 at the Print Shop during the
calendar year.  These are totals and may involve multiple purchases per vendor.

� You make a $100 purchase at the Office Supply Store in October.
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Procedure 1 (lump-sum for each vendor):

� Create a single lump-sum entry on 9/30 for each vendor for the previously reported
amounts ($780 at the Office Supply Store, $900 at the US Postal Service etc.).

� Create a $100 disbursement for the Office Supply Store on the correct date in October.
(Lets use 10/1).

The new transaction will correctly report as an itemized expenditure because FECFile 3 knows that
the year-to-date total for the Office Supply Store is over $200.

It is possible, though not recommended, to create a single lump-sum entry for all
previous operating expenditures regardless of vendor. This is possible because operat-
ing expenditures do not report a year-to-date amount per vendor.  This method  re-
quires you to track disbursement totals per entity until the end of the calendar year. If
a vendor eventually receives enough to exceed the itemization threshold, the software
will not have enough information to automatically itemize them and you must make
adjustments to compensate. If the payment itself is over $200 it requires no special
handling. If it is $200 or below, and the year-to-date aggregate for that vendor is above

$200 ,  you must force the transaction to itemize by single clicking on the transaction in the Dis-
bursements View and choosing Itemized from the Edit menu. Use this method only in extreme
cases where data entry time is very short and reporting deadlines are very near.

Procedure 2 (single lump sum for all vendors as described above)

� Create a single lump sum disbursement for the entire amount of prior operating
expenditures this year. (Create a fictitious vendor for the transaction.)

� Create a $100 disbursement for the Office Supply Store on the correct date in October.

� Force the $100 disbursement to itemize by selecting it from the Disbursements View
and choosing Itemized from the Edit menu.

You may combine any of the three methods (full entry, Lump sum per vendor, single lump sum)
for adjusting aggregates depending on which method best fits your needs.  However, it is important
that you remember, or take note of, which method was used and when.

Obligations from prior years

Outstanding obligations from prior years must carry forward until they reach zero balance. This
means that all active obligations, no matter how old, must be entered into FECFile so they will be
reported properly.  Because the software will not allow you to create transactions that are outside
the date range of the current report, you must create past reports covering the date range during
which the obligations were incurred.

Example: Your first electronic filing will be a year-end 2000 report and you have a loan that dates
back to June 3, 1998 and another from January 1,  1999.
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Procedure:

� Create a Year-End report that covers January 1, 1998 to December 31, 1998.

� In that report, create an entry for the full amount of the loan on June 3rd.

� Create a loan repayment for the entire amount of previous repayments to the loan. This
should be done on or after the date the loan was created.

� Create a report covering January 1, 1999 to December 31, 1999.

� Create an entry for the full amount of the original loan received on January 1.

It is necessary to create two previous reports because reports cannot cross years - one report cannot
go from Jan 1, 1998 to Dec 31, 1999. It is recommended that each report be created as a year-end
report and cover an entire year. In this case, you would create a year-end report covering 1/1/1998
to 12/31/1998, and another covering 1/1/1999 to 12/31/1999.

Outstanding debts, like loans, must be entered into FECFile. Unlike loans, prior debts need not be
created on the actual origination date as that date does not appear on Schedule D.  All previous
payments on a debt can be created as a single, lump sum payment, made on any date after the
obligation was arbitrarily created (but before the current reporting period). Once all the obligations
are entered:

� Select the report that contains the latest obligation entry that is prior to the current re-
porting period. In the example above, that would be the year-end 1999 report.

� Create a lump-sum repayment for each debt. The amount of each repayment should be
the total amount previously paid against each debt.

Follow the detailed instructions in chapter 4 for loan and debt repayments. Remember that the dates
of the repayments are arbitrary, and need only be later than the creation date of the obligation and
prior to the current reporting year. In the example above, all payments could be dated 12/31/1999
and all subsequent reports would report the obligations correctly. Payments made on these obliga-
tions in the current year should be made in the correct reporting period on the correct date.

Quitting the Application

When you are finished with a session of FECFile, be sure to save your work.  Go to the
File menu and select Save.  If this is a new file, you will be prompted to supply a file
name. Go to the File menu and select Close.  This will close your file, not the program.
To close FECFile, go to the File menu and select Exit.  If you did not save the file
before closing, the program will prompt you to save changes.   However, it is best to

get in the practice of actively saving you work instead of depending on prompts.
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Backing up your file

You must back up your data. Though you may never have a problem that requires
restoring from backup, it only takes one electrical spike or hard drive failure to erase
many hours of work. The best way to back up any information on a computer is to
rely on software that is specifically designed to perform this function. If you are
already using such a system, make certain you add the folders containing FECFile 3
and your .dcf files to your backup routine. If you are not using a backup system and

don’t wish to add one to your system, you can copy your .dcf files to a safe location.

To a floppy, CD or other removable media:
Close FECFile. Put a diskette, CD or cartridge in the appropriate drive.  Right click on the Start
button and choose “Explore”. Find and open the FECFile 3 directory. Find your .dcf file and single
click on it with the left mouse button. Select Copy from the Edit menu. Click on the drive that
contains your floppy, CD or removable storage device.  Choose Paste from the Edit menu. This
will copy your file to the backup location.

To a network drive:
Close FECFile.  Right click on the Start button and choose “Explore”. Find and open the FECFile
3 directory. Find your .dcf file and single click on it with the left mouse button. Select Copy from
the Edit menu. Click on the network drive where you intend to store your file. If you are using a
particular folder, find and open it.  Choose Paste from the Edit menu. This will copy your file to the
network drive.

Make it a habit to have at least a week’s worth of sets of backups. For example, use five
separate diskettes.  On Monday, backup to diskette #1, on Tuesday, back up to diskette #2
etc.. This way, even if a hard drive crash occurs during a backup, you always have a recent
backup diskette to fall back on.
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Review - Chapter 2

1 FECFile requires Windows 95 or higher or NT 4.0 or higher operating system.

2    Create a file to contain all of your reports.

3    Fill in your committee information.

4    Select the report due-date for your next report.

5    Save the file.

6 If you are starting after the first reporting period of the current year, and you have previous
activity in that year, you must create a report for the beginning of the year to hold previous transac-
tions (for aggregating and YTD numbers).

7 If you have outstanding obligations from previous years, you must create reports for those years
to create the obligations and payment information so that balances will be correct.
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Of “Reports” and “File”

Some users are initially confused by the concept of  File vs. Report. It
is important to define these concepts correctly to avoid extra work
and headaches later.

The first time you use the software, you must create a file in which
you will store all of your reports for one committee (see chapter 2).  If
you are working with multiple committees, you should create a file
for each committee.  When using the software, you will always begin
by opening your file.  Files that can be read by the program end in the
extension .dcf (for example, the file name might be pac.dcf).

When your file is open, choose Reports from the View menu.  In the Reports View, you will see all
of the reports in your file. By creating all of your reports within one file, the software will have the
ability to track aggregates, calculate itemization thresholds, etc.  If you start a new file for every
report, the software will not be able to associate reports. (For example, Janet Rankin gave $200 in
the Mid-year report, which was saved in a file called midyear.dcf.  Janet gave another $200 in the
Year-end report, which was saved in a file called yearend.dcf.  Janet’s address information would
have to be entered into both files and her aggregate year-to date total would be incorrect in the year
end report.)  If the data is entered into separate files, as the example above depicts, merging the data
can be a difficult task (especially in the case of loans).

Please be sure to create one file per committee.

NOTE - You do not send the FEC your file (*.dcf). You will be
submitting a filing (*.fec).  This means unitemized individuals, etc.
are stored within your file, but the individual names, etc. will not
be sent to the FEC.  This will be discussed further in the “Submit-
ting your report” section.

Views

FECFile presents all information in windows, which are also called
Views.  Each View displays objects of a specific type (e.g. the Indi-
viduals/Organizations View displays a list of individuals and or-
ganizations, the Reports View displays a list of all reports, the Re-
ceipts View displays a list of all receipts, etc.). Understanding the

C
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Views will make navigation of the software simple.

When you go to the View menu and highlight a View from the list, that window will be activated
and open (fig. 1).

There are 8 windows that are Views in FECFile:

1 Individuals/Organizations - all individuals and organizations (and Schedule H events)
that have financial interaction with your committee.

2 Reports - a history of all reports contained in your file.

3 Summary page - a replica of the Summary Page and Detailed Summary page of the
selected form type.

4 Opening Cash - the amount of cash on hand at the beginning of the year.

Note: You only enter opening cash the first time you use FECFile.  The program will
automatically carry over closing cash for a previous report as opening cash for the next
report, even over multiple reporting years.

5 Receipts - all money and goods received by a committee (inbound).

6 Disbursements - all money and goods disbursed by a committee (outbound).

7 Obligations - all loans, debts and other obligations a committee owes and is owed.

8 Validator - verifies that all transactions are reported in the correct filing format.

Working with Views

Views serve two basic functions in FECFile. Data entry and data manipulation (sorting, editing,
etc). Some Views, such as Reports and Individuals/Organizations, allow the creation of new entries
and editing existing ones from the same View. The Summary page View allows creation of new
transactions and display of total amounts, but editing existing information is not available. Other
Views allow sorting and editing of information but, in most cases, do not allow addition of new
items.

Views can be customized to suit the user in the following ways:

� All View columns can be made wider or narrower. Place your mouse on the line to the
right of the column name.  You will see a double arrow cursor. Hold the left mouse
button down.  While holding the left mouse button, move your mouse to the right to
make the column wider, and to the left to make the column narrower. FECFile Views
remember their window-size and column-width when the program is closed.

� Information in most Views can be sorted by clicking on the desired column header. For
example, the Receipts View can be sorted by contribution date by clicking on the word
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Date at the top of the column. Clicking on the Amount column header puts the View
in amount order from smallest to largest. Click on it again and the order is reversed.

� You can automatically arrange numerous open Views. Go to the View menu, choose
Windows and select any of the four options.

Please refer to Concepts and Terms in chapter 1 if you are unfamiliar with cascade, etc..  If you
want to close a View, select the FECFile picture on the left of a View and select Close.  Again
you can arrange the Views by going to View, Window and selecting the View you want (for
example, Tile Horizontal).  The Views will  be arranged without the View you closed.

The Views, in detail

Individual/Organizations
To activate the Individual/Organization screen, go to View on the menu bar and select Individuals/
Organizations.  If you already followed the steps to set up a new committee, you will see your
committee name in the View. The Individual/Organization View allows both creation of new records
and editing of existing ones.

NOTE - There will be brackets around the information in the type column (for example, it might
say [PAC]).  The brackets indicate the master committee that is associated with this file.

There are three columns: Name, Type and
Filer ID.  All of these columns can be sorted
by clicking on the column name (fig. 2).  One
click sorts the information from A-Z; a sec-
ond click sorts from Z-A. In the Type col-
umn, ORG indicates an organization such as
a vendor or lending institution. IND stands for individual. CCM is Campaign Committee and PTY
indicates a political party.

There are three basic things you can do to an entity: create, modify and delete.

Create (New) - This feature allows you to enter new entities into your file.

� Go to Edit on the menu bar and se-
lect New.

The first screen requires you to identify the type
of entity (for example, business, individual or
campaign committee) (fig. 3).  It is important to
select the correct type as this information is used
to properly display the name of the entity.

� Select the Details tab (fig. 4) and en-
ter the information requested. The name and address information can be entered manu-
ally.

fig. 2

fig. 3
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If the entity is a registered Fed-
eral committee, use the Lookup
button to save time and ensure
that the information is correct. See
the section “Using the Lookup
Feature” later in this chapter.

� There are three drop
down lists available
on the Details tab:
prefix, suffix and
state.

To access the drop down lists,
you can either start typing or click
on the downward arrow.  If your
selection cannot be found in the
drop down lists of the prefix and
suffix fields, you have the ability
to type in the text as you would
like it to appear.  The State field will only allow you to select from the drop down list.  If you are
entering a country, instead of an American state, you should chose “foreign country” from the list
provided. To select a state you can either click on the downward arrow to the right of the field, or
you can type the first letter of the state.  In the case of  multiple states beginning with the same
letter, you should continually type the first letter until the state you want is highlighted.  For ex-
ample, if the individual you are entering is from Indiana, you should type “I” three times in the
State field to get the correct state.  If you type “I” one time you will get Idaho.  If you type “I” two
times you will get Illinois.

� The Special tab of the Individual/Organization screen is only necessary if you are re-
quired to enter federal candidate information (office, state and district) or an event date
for a joint federal and non-federal activity.

The candidate information should only be entered if the entity is a federal candidate. That is why
you will only see House, Senate and Presidential as options in the office drop down list.

When you are finished with the entity, click on the OK button.  The entity will then be added to your
Individuals/Organization View.

Modify - This feature allows you to make changes to an entity that has already been entered into
FECFile.

� Select the entity from the Individuals/Organizations View.  With the entity highlighted,
go to Edit on the menu bar and select Modify, or right click on the item and choose
Modify  (Double clicking on an entity is the same as choosing Modify).

� Click on the tab (Type, Details or Special) that contains the information you would
like to edit.  After you make the changes, click OK.  A prompt will ask you if you would
like to replace the object; click Yes.

fig. 4
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The changes will appear in all reports where the entity had a transaction.  In other words, the
software will not remember that Jennifer Robinson lived in Aspen, Colorado, when she donated in
the Mid-Year report but in the Year-End report she lives in Boulder, Colorado.  FECFile will only
maintain the latest recorded information.

Entities should only appear once in the Individuals/Organizations screen.  If an
entity has been entered more than once, the aggregate could be incorrect.  It is im-
portant to modify an entity when a correction is needed, instead of creating an addi-
tional entity.  If you enter two individuals named Edward Burke (even with the
exact same address information), the software will assume these are two different
people.

Delete - This feature allows you to completely remove an entity from your file.

� Select the entity from the Individuals/Organizations View.

� With the entity highlighted, go to Edit on the menu bar and select Delete.

� You will get a prompt asking if you are sure you want to delete the selected object; click
Yes.  The entity will be removed from your file.

You can only remove an entity if there are no transactions associated with it.  If you attempt to
delete an entity and there are transactions associated, you will be told “This object is required by at
least one other object and cannot be deleted.”  If the transactions are incorrectly associated with an
entity, first delete the transactions. This will make it possible to delete the entity.

Using the Lookup file

Under the Details tab of the Individual/Organization information dialogue, there is a button that
says Lookup (it will be to the right of the FEC ID field).  This feature enables you to enter a federal
committee or candidate name and the software will fill in the rest of the basic committee informa-
tion (fig. 5).  For example, your committee gave money to Friends of Democracy.  All you need to
enter is the committee’s name in the Name field; then click Lookup.  This feature saves a lot of data
entry time as well as providing you with the necessary information you might not have readily
available (i.e. office, state and district). There are times when the Lookup feature is grayed out.  If

fig.5
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the entity type you have chosen is “Business, corporation, financial-institution, union, non-federal
bank account, etc.”; “Individual other than a candidate” or “Event (joint federal/non-federal)” you
will not be able to use the lookup.

� You can sort the entities in this FEC ID Lookup dialog by clicking on the relevant
column header.

This is useful if you want to find a particular candidate or committee using some criterion other
than the name.  Click the Committee/Candidate Name one time for an A-Z sort or two times for
a Z-A sort.  All other columns only sort from A to Z or from smallest to largest number (click
once on the column header).

� All columns can be made wider or narrower by placing your mouse on the line to the
right of the column name.  You will see a double arrow cursor. Hold the left mouse
button down.  While holding the left mouse button, move your mouse to the right to
make the column wider, or to the left to make the column Narrower.

� The Prev (i.e. previous) and Next buttons on the FEC ID Lookup screen can help you
locate the proper committee.

When you click Prev or Next, with a committee/candidate name highlighted, you will cycle
through a list of candidates and committees that are related by FEC ID number.  For example,
you gave money to Melanie Haskell for Congress committee.  You entered Melanie Haskell in
the Last Name field of the Individual/Organization Information screen and then clicked Lookup.
When the file opens you are brought to Melanie Haskell for Congress.  If you then click on Next
or Prev, you will see all committees associated with Melanie Haskell.  When the committee
that received the disbursement appears, click Copy All (if you already have the name and ad-
dress information, you can choose Copy ID to add the committee ID).

After you have clicked Copy All from the FEC ID Lookup, a screen will appear displaying all of
the information that will be copied into your file.  The check boxes are automatically checked
because all the information is needed for a committee or candidate.  However, if you do not
want a piece of that information copied you can remove the check by clicking in the check box.

NOTE - if you remove a check from a field when creating an entity, the next time you use the
Lookup feature, that checkbox will remain unchecked.  To return the check mark in a field, click
the box between the field name and the information.

To bring the information into your file, click OK.  You will be returned to the Details tab of the
Individual/Organization Information screen.  If you selected a candidate campaign committee, the
necessary fields on the Special tab will also be filled automatically.  Click the OK button to add the
entity to your Individuals/Organizations View.
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Updating (Downloading) the Lookup File

The Lookup file will send a notice to you when it is more than 30 days old.  The FEC updates its
master list of committees and candidates on a daily basis.  The FEC’s master list is part of the
FECFile installation (a file called export2.cm contains the information).  The software is set up to
notify you once every 30 days. However, you have the ability to download a recent copy of the file
whenever you choose. It is a good idea to do this when you install the program, as the file could be
months out of date by the time the program is installed.

The notification - When you open your file, if your Lookup table is older than 30 days, you will get
a notice on your screen asking if you would like to download a copy of today’s database (fig. 6).  If
you answer by clicking No, the file will not be updated but you will be able to enter transactions
into FECFile.  If you answer by clicking Yes, the FECLoad Settings window will appear asking you
to choose your filing method (ie., the communication method you will utilize to download the latest
file).  Your options are TCP/IP (an Internet connection) or Dialup (a modem connection) from the
Download tab.  All the other fields on this tab will be inactive (shaded gray).  The configure tab will
vary according to the filing method you chose.  If you selected TCP/IP on the Download tab, the
Configure tab will have herndon4.sdrdc.com as the hostname (this is the name of the server that
has the export2.cm file available for download) and the Agency ID will be FECDL.  If you selected
Dialup from the Download tab, the Configure tab will have your COM port set as 2; the Baud rate
set as 19200; the Dialup string as ATDT17038346968 and Agency ID as FECDL.  The COM port
is the communication port that runs your modem.  If you cannot connect with this setting, or if you
know you are using a different COM port, please change the COM port number in this field (possi-
bilities COM port 1, COM port 2, COM port 3 or COM port 4).  In addition, if you are using a
different Baud rate, please change the setting.  The program defaults to these two setting since they
are the most commonly utilized.  Do not change the Dialup string or Agency ID unless you are
instructed by the software’s technical support staff.

NOTE - IF you choose TCP/IP, you must be connected to the Internet prior to downloading.

When you click OK from the settings screen, you will be asked where you want to save the Lookup
file (export2.cm).  The software should default to the location where the program is installed.  It is
important to save this file in the same location as the program.  The file will default to export2.cm.
Do not change the name of this file.  Click OK.  If you are asked “do you want to replace the
existing file?”, click Yes.  The download process will begin. It may take several minutes depending
on the speed of your modem and/or quality of your Internet connection.

During the download, you should be looking at a screen that says FECload in the upper left corner.

fig.6
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Inside FECload you will see a window displaying the download results.  A few messages will
appear on your screen letting you know the program is about to download.  The program might
pause after it says “Requesting export2.cm”; do not
worry, the process should continue.  The next message
should say “Server response …” and  in the bottom
right corner, a number that is growing as the file is
downloading (the number represents the bytes being
transferred).  Currently the file is about 4 megabytes
compressed.  The speed of the download process is
dependent upon your connectivity.  When the down-
load is near completion, you may see a window telling
you it is “Working”.  Afterwards, you will get another window saying “The file can be decrypted
by these keys: SDRDNLD1.” (fig. 7)  Click OK.  Again, you may get a window letting you know
FECload is “Working”, followed by the word “Succeeded” as the last line on your screen.

Reports
The Reports View displays a history of all reports contained in your file (fig. 8).  To activate the
Reports window, go to View on the menu bar and select Reports.  If you have already followed the
steps to set up a new committee, you will see one report in the window.  All of the information from
this View is used to generate the Summary Page of an FEC report.

There are eight columns: Type, Filed on, Date from, Date to, Opening Cash, Election, Signed by
and Description.  This View has an automatic sort.  The sort is based on the report coverage dates
(i.e., Date from and Date to) and the Filed on date.  The user does not have the ability to change the
order of reports in this View.  However, you do have the ability to size the columns. In other words,
all columns can be made wider or narrower.  For further explanation refer to the Individuals/Orga-
nizations View.

There are six things you can do to a report: create, modify, delete, file, amend and purge.

Create (New) - This feature allows you to enter new reports into your file.  With the Reports View
active:

�Go to Edit on the menu bar and select New.

The first screen requires you to identify the Type of new report.  If you are unsure of the
report type you should select, please contact the FEC to find out if you are a monthly or
quarterly filer.  Report types are based on the reports’ due date.  For example, the July 20
Monthly report is due on July 20 and covers June 1 through June 30.  If you know the
report type you want to create, select it from the list; then click OK.

fig.7

fig.8
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� Next the Details tab
will appear. (fig. 9)

Enter the report cover-
age dates in the From
and To fields.  The ex-
ample above was a
March 20 Monthly re-
port, so in the From field
enter 2/1/2000 and in
the To field enter 2/28/
2000.  For more infor-
mation about date for-
mats, please refer to the
section on setting up
your committee in
Chapter 2.

� The Election fields
(State and Date) will be
inaccessible unless you
are creating an election
report (for example, a
30-day Post-General).
If you are creating an election report, select the state of the committee and the date of the election.

� Select the Treasurer in the Signed by field.  If you have previously entered the Treasurer (or
Assistant Treasurer’s name) in the Individuals/Organizations View, you will be selecting their
name from the list provided.  Hit tab until the field is activated (you will know the field is active
because a name will be highlighted and no other field will have highlighting).  Begin typing the
individual’s name.  If you entered the person as an Individual and filled in the fields correctly, the
person should appear as last name, first name.  The person’s name should be highlighted.  If the
name appears, click OK.  If the name does not appear, you can use the scroll bar to the right of the
Signed by field to look for the individual’s name.

NOTE - When you are typing a name in the Individuals/Organizations fields, FECFile expects all
of the letters to be entered consecutively.  For example, to get Rankin, Janet - type “RAN”. Con-
tinue typing letters until the correct name appears.  If you type R …… A ……. N (the dots represent
time passing) FECFile will assume each letter is the first letter.  The level of data entry speed
required is minimal. However, if you notice the scroll constantly takes the letter you are entering to
be the first letter, you might want to use the arrows to search for a name instead of typing the name.

If you have not entered the Treasurer’s name in the Individuals/Organizations View, you can create
the individual from the Signed by field.  With the Signed by field active, click your right mouse
button (or press Insert on your keyboard) and you will be brought to the Individuals/Organizations
View.  When setting up the Treasurer, select individual. (Some committee’s Treasurer and candi-
date are the same person. If you are in this situation, please select candidate.)  Enter all of the

fig.9
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information requested on the Details tab and, if required, the Special tab).  When all the informa-
tion is entered, click OK.  The program will return you to the Report Information tab and your
Treasurer’s (or Assistant Treasurer’s), name will be highlighted.  (The entity will also appear in the
Individuals/Organizations View.) For more detailed information on entering individuals and Orga-
nizations, see the section on Individuals and Organizations earlier in this chapter. The Filed on and
Filing ID fields will be grayed out.  These fields will be discussed in Chapter 6, Filing Your Report.

NOTE - You can select the person who will sign the report when creating the report, or you can
wait until you are ready to file the report.
If you select one person,  but a different
person signs the report, you have the abil-
ity to edit the information in this field.

The Special tab allows you to check the
multi-candidate box status as well as the
new committee address box (fig. 10).  If
you are a candidate committee (Form 3),
you will find the election activity designa-
tion check boxes on the Special tab.

Modify - This feature allows you to make changes to a report’s basic information: coverage dates,
election state, election date, person who signed the report, identify a change of address, identify
multi-candidate status, and designation of election activity.

To modify a report, activate the Reports View and select the report you would like to modify.  Once
the report is highlighted, select Modify from the Edit menu.  All of the fields on the Details and
Special tab that apply to your report will be available for you to make the necessary changes.
Please note - FECFile does not allow you to edit the report type.

NOTE - The modify option is disabled on reports with “Filed on” dates.  To make changes to a
report that was submitted to the FEC, you must file an amended report.  Please see the section on
Amending Reports in chapter 7 for more information.

Delete - This feature allows you to delete a report from the Reports View.  Reports can only be
deleted if there are no transactions associated.

To delete a report, activate the Reports View and select the report you would like to remove.  Once
the report is highlighted, select Delete from the Edit menu.  A prompt will appear asking if you
want to delete the selected object.  If you click Yes, the report will be deleted.

NOTE - If you have transactions associated with the report you are attempting to delete, you must
first remove the transactions from the appropriate View (for example, transactions reported as
receipts must be deleted from the Receipts View).

fig.10
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File Report - This should be done once all transactions have been entered for a report.  When you
enter the requested information on this screen, FECFile assumes your report has been filed and you
will not be allowed to make any changes to the data. To file the report, activate the Reports View
and select the report.  When the report is highlighted select File report from the Edit menu.  You
will have three fields available: Filed on, Filing ID and Signed by. (fig. 11)

NOTE - You have the ability to file the report from all Views (i.e., You do not have to be in the
Reports View).  Go to the Edit menu and select File Report.

� In the Filed on field
you enter the date you
will be filing the report.
The information en-
tered in this field will
appear on the Summary
Page of an FEC report,
in the Date box.  Follow
the conventions dis-
cussed previously for
entering the date format
(for example, 01/01/
00).  The date entered
must be later than the
reports coverage dates.

� If you enter an in-
valid date, FECFile will
highlight the date field
when you click OK.
The software will not
allow you to pass this
screen until you have entered an acceptable date, or until you have cleared all information from the
Filed on field.

Once you have a date in the Filed on field, the report will be locked.  To make corrections or add
transactions, you can remove the lock by deleting the date in this field.  However, we do not recom-
mend you remove the date on a report that has been submitted to the FEC.

You will not know your filing ID number until you submit the report to the FEC. Please ignore this
field until you receive confirmation from the FEC of your electronic filing. A filing ID is unique to
every report submitted electronically.  The ID will always begin with “FEC-“ and it will be fol-
lowed by a number.  For example, the first electronic filing ever received by the FEC has the filing
ID of FEC-16.  You will need to know the filing ID if you submit an amended filing.  The informa-
tion entered into the Filing ID field will carry to the Description column of the Reports View.

The Signed by field was discussed in the section on creating a new report.  The name of the indi-
vidual who “signs” the report should be highlighted. Click OK to save the information entered.

fig.11
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Click Yes to replace the object.

Purge
Back up your file before purging! The purge function provides a way to easily remove unwanted
transactions from a .dcf file. This should not be necessary in the normal course of using the soft-
ware. It can be handy in cases such as importing incorrect information into a new report. The entire
report can be purged rather than each transaction being deleted separately. Actual reports that have
been uploaded to the FEC should not be purged as this will make it impossible to amend these
reports should it be necessary.  Only reports that have been marked with a “Filed on” date may be
purged.  Purging does not remove loans or Debts, as they may effect future reports. To purge a
report, single click on the report in the Reports View and choose Purge from the Edit menu. You
will be asked to select a filename. The purged report will be saved as a new file, thus preserving the
original file with all transactions intact. The default filename will be the same as the original file.
You must change the file name.

Summary Page

The Summary page View displays the equivalent of the Detailed Summary Page of an FEC report.
The lines on this screen will be different depending on the form set you are using.  This is the View
you will be working on most often, since most transaction data entry is done from this screen.  To
activate the Summary Page View, go to View on the menu bar and select Summary page.

NOTE - If the Summary Page is blank, you do not have a report activated.  Look in the bottom right
corner of your screen. You should see the active report’s coverage dates and report type code.  If
you do not see the information you need, activate the Reports View, select the correct report, and
then return to the Summary page View.  Don’t forget: If you have a Filed on date on the report, you
will not be able to enter transactions.

There are seven columns in the Summary page View: Schedule, Line#, Description, THISP.I,

THISP.U, CTD.I and CTD.U.  The first three columns remain static. (fig. 12)

The columns can not be sorted in the Summary page View.  However, all columns can be made
wider or narrower by placing your mouse on the line to the right of the column name.  You will see
a double arrow cursor. Hold the left mouse button down.  While holding the left mouse button,
move your mouse to the right to make the column wider, and to the left to make the column nar-
rower.

The Line# column shows the user the FEC schedule that will be generated if itemization thresholds
are met.  The schedules are discussed thoroughly in the Campaign Guide.  You should know and

fig.12
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understand the reporting requirements for the types of transactions you report. The FECFile soft-
ware and its documentation are not intended as a guide to FEC reporting, and should not be
used as a substitute for the Campaign Guides.

Here is a quick index of schedules created by FECFile:

Form 3 and 3X

Schedule A: Provides detailed information for each receipt that is required to be itemized.

Schedule B: Provides detailed information for each disbursement that is required to be itemized.

Schedule C: Shows all loans, endorsements, and loan guarantees the committee receives or makes.

Schedule C-1: Shows all loans and lines of credit made by lending institutions to the committee.
This schedule requires a bank signature.  When filing electronically, you are required to submit a
paper copy of Schedule C with the bank signature by mail after you have filed.

Schedule C-2: Lists all guarantors of loans and lines of credit. (C-2 only exists in electronic fil-
ings).

Schedule D: Shows debts and obligations owed to or by the committee that are required to be
disclosed.

Form 3X (only)

Schedule E: Shows all independent expenditures made during the reporting period. Schedule E
may also be used to separately disclose last-minute independent expenditures of $1,000 or more
made between the 20th day and 24 hours before the date of an election. Schedule E also requires
submission of a paper copy (notarized and sworn to). This document must be sent to the FEC via
traditional means (U.S. Mail, courier, etc.).

Schedule F: Shows all coordinated party expenditures. (Used by party committees only.)

Schedule H1: Shows method of allocation for shared federal and nonfederal administrative ex-
penses and generic voter drive costs.

Schedule H2: Shows allocation ratios for shared federal and nonfederal activity, including indi-
vidual fund-raising events, exempt activities, and direct candidate support appearing on the report.

Schedule H3: Shows transfers from nonfederal accounts to federal accounts for the purpose of
paying allocable expenses.

Schedule H4: Shows disbursements for shared federal and nonfederal activity.

The line number tells the user the line of the Detailed Summary page to which the information will
be assigned.  Each line number of the Summary Page generates a separate schedule to support the
line.  Some lines of the Detailed Summary page are not in the Summary page View. If you do not
see a line, that means the program is generating that information automatically.

NOTE - For more detailed descriptions of the report line numbers, refer to the Campaign Guide for
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your committee type.

� The column THISP.I (this period’s itemized totals) is the aggregation of the current
reports itemized transactions.  On the FEC form, these totals appear in Column A  (TO-
TAL THIS PERIOD) of the Detailed Summary Page.  Before you enter any transac-
tions, this column will be blank

NOTE - To see a previous report’s itemized totals for a particular line:  Go to View on the menu bar
and select Report.  Highlight a report.  Go to View on the menu bar and select Summary page.  You
will see the report’s totals for the Detailed Summary page.

� The column THISP.U (this periods unitemized totals) is the aggregation of the current
report’s unitemized transactions.  The transactions that aggregate into this column’s to-
tals will not generate a Schedule page.  On the FEC form, these totals appear in Column
A of the Detailed Summary Page.  Before you enter any transactions, this column will
be blank

� The column CTD.I (calendar-to-date itemized totals) is the aggregation of the year-to-
date itemized transactions.  On the FEC form, these totals appear in Column B (CAL-
ENDAR YEAR) of the Detailed Summary Page.  This column will be the total
of itemized transactions from past reports.

� The column CTD.U (calendar-to-date unitemized totals) is the aggregation of the year-
to-date unitemized transactions.  On the FEC form, these totals appear in column B of
the Detailed Summary Page.  This column will be the total of unitemized trans-
actions from past reports.

� All columns can be made wider or narrower by placing your mouse on the line to the
right of the column name.  You will see a double arrow cursor. Hold the left mouse
button down.  While holding the left mouse button, move your mouse to the right to
make the column wider, and to the left to make the column narrower.

To create a transaction (e.g. receipt, disbursement, loan, debt, etc.), double-click the line on the
Summary Page that represents the transaction (e.g., 11(a), Individual Contributions).  The details of
data entry for specific transaction types can be found in Chapter 4, Building a Report.  As transac-
tions are added, the numbers on the Summary page View change to reflect those transactions.

To edit the transactions that have been entered into a report, activate the related View.  For ex-
ample, to edit a receipt, you activate the Receipts View.  This will be explained further in the
sections that explain the other Views (Opening Cash, Receipts, Disbursements, Obligations).  Cloning
of transactions (very helpful for payroll deductions) also occurs on the four Views mentioned above.
This will be discussed further in the following sections.

fig.10
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Opening Cash

The Opening Cash View displays the beginning cash-on-hand entered for the first report in FECFile.

This View is only needed if you have to make adjustments to original cash-on-hand.  To activate
the window, go to View on the menu bar, and select Opening Cash. (fig. 13)

There are five columns in the Opening Cash View: Line#, Date, Individual/Organization, Amount,
and CTD.  All the information in these columns is directly from the entered data on the Summary
page View.  Line# will tell you the line of the FEC form that discloses the opening cash.  Notice a
small letter “u” next to the line number.  The “u” means this transaction is unitemized.  All transac-
tions on the Opening Cash View will be unitemized.  The Date column will tell you the first time
cash-on-hand was entered into FECFile.  The Individual/Organization column should be blank
(this field will be grayed-out on the Item Information tab).  The Amount column will contain the
original cash-on-hand amount that was entered on the Summary page View.  The CTD column will
be zero during the first report (the original report that started in FECFile).  The CTD column, in the
Opening Cash View, will be blank on all future reports.

The columns can be sorted.  However, it is highly probable that you will never have more than one
entry in this View.  As usual, all columns can be made wider or narrower by placing your mouse on
the line to the right of the column name.  You will see a double arrow cursor. Hold the left mouse
button down.  While holding the left mouse button, move your mouse to the right to make wider,
and to the left to make the column narrower.

The Opening Cash is entered from the Summary page View. See Chapter 4, Building a Report, for
details.

To modify opening cash - activate the Opening Cash View.  Select the line you wish to edit, go to
Edit on the menu bar and choose Modify.  Make the needed corrections on the item information tab
that appears.  Click OK, and Yes, to replace the object.

FECFile version 3 automatically carries the beginning and ending cash balance forward from year
to year.  In other words, if the Year-End report for 1999 had a “cash on hand at close of reporting
period” of $10,000, the first quarter report of 2000 will have $10,000 for the “cash on hand at
beginning or reporting period”.  Do not enter cash on hand at the start of every year or your totals
will be inflated!  FECFile will compute the calculations for you automatically.

Receipts

The Receipts View displays a detailed history of all money and goods received by your committee.
To activate the Receipts window, go to View on the menu bar and select Receipts.

fig.13
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There are six columns: Line#, Date, Individual/Organization, Amount, Election and YTD.  This
View can be sorted by any of the columns (fig. 14).  If you click a column name once, the informa-
tion is sorted one way. If you click the same column again, the sort will be in the opposite order (i.e.
One click on Individual/Organization will sort the names A-Z and two clicks will sort the names Z-
A).  All columns will sort in the order determined by the column chosen (e.g. the transaction will
remain intact).  You can not sort in more than one order at a time.  For example, FECFile will not
sort all of the transactions for $200 on 4/5/99.  You can only choose one criteria for the sort.  In
addition, you can only sort information that appears in the View.  So, you could not conduct a sort
on the Purpose / Description that was entered for a transaction, since the information is not dis-
played in the Receipts View.

NOTE - You have the ability to size the columns.  All columns can be made wider or narrower.  For
further explanation, refer to the Individuals/Organizations View.

There are four basic things you can do in the Receipts View: itemize, clone, modify and delete.

Itemize - If the year-to-date total of an individual or an organization is less than the FEC’s reporting
threshold, the transaction will automatically be counted as unitemized.  By default, FECFile auto-
matically categorizes receipts as itemized or unitemized based on the year-to-date figures for the
contributor. There may be occasions when you will want to itemize a transaction that would nor-
mally be below the threshold, or to unitmize one that is over the threshold. To do this:

� Enter the receipt into the system. If it is below the threshold you will notice a lower case
“u” next to it in the Receipts View.

� Single click on the receipt in the Receipts View.

� Choose Itemize from the Edit menu.

If the transaction was originally unitemized, it will now be itemized. If it was Itemized, it will now
be unitemized.

NOTE - A dialogue box may appear when you select a transaction and change its default itemiza-
tion.  The screen says: “If you itemize or de-itemize this item interactively then the filer program
cannot subsequently re-itemize this item automatically.  Are you sure you want to [de-]itemize this
item?”.  The message means that if you force the itemization of a transaction, the software will not
be able to change the itemization automatically.

fig.14
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Clone - This feature allows you to make copies of a receipt that has already been entered into
FECFile.  This is useful if you have the same contributors continuously giving money.  For ex-
ample, you might work for a PAC that has payroll deductions.  In this situation, the individual
might donate the same amount on a regular basis.

� Select the last receipt of this individual from the Receipts View.  (Items are cloned from
the Receipts View, not the Summary page View.)

� With the transaction highlighted, go to Edit on the menu bar and select Clone.  A copy
of  the transaction will appear.

� Enter the current contribution’s date.  If all the other information is the same, click OK.
If not, make any of the necessary changes in the appropriate fields.

NOTE - The FEC requires a committee to explain “payroll deduction” in the Purpose / Description
field.  If the deductions take place on a time schedule, for example, every two weeks, be sure to type
“biweekly payroll deduction” and include the amount deducted.

Modify - This feature allows you to make changes to a receipt that has already been entered into
FECFile.

Find and highlight the transaction in need of modification, in the Receipts View.

� Choose  Edit from the menu bar, and select Modify.

� Click on the tab (Details, Endorsement or Schedule C-1) that contains the information
you would like to edit.

� After you make the changes, click OK.  A prompt will ask you if you would like to
replace the object. Click Yes. The changes will be made to the transaction after you
click Yes to replace the object.

NOTE - Remember, if you must change the address information of an entity, you make the changes
in the Individual/Organizations View.  A change made to the address information of an entity will
be carried to all transactions associated to that entity.

Delete - This feature allows you to remove receipts that have been entered into FECFile.  If you
want to delete, instead of modify, the transaction:

� Activate the Receipts View.

� Locate the receipt you want to delete, and highlight it.

� Choose Edit from the menu bar and select Delete.  The delete option will  only be avail-
able if the transaction was entered in the current reporting period.  In other words, you
cannot delete contributions from a report that has been filed.  To remove transactions
from previous reports, refer to the section on Amendments in chapter 7.

When a receipt is deleted from the Receipts View (except in the case of amendments), the transac-
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tion will be completely removed from your file.  The only way to bring a receipt back into the file
after it has been deleted is to reenter the transaction.

Disbursements

The Disbursements View displays a detailed history of all money and goods disbursed by a com-
mittee (outbound).  The Disbursements View and the Receipts View are functionally the same.  To
activate the disbursements window, go to View on the menu bar and select Disbursements.

There are six columns: Line#, Date, Individual/Organization, Amount, Election and YTD.  This
View can be sorted by any of the columns.  If you click a column name once, the information is
sorted one way. If you click the same column again, the sort will be in the opposite order (i.e. One
click on Individual/Organization will sort the names A-Z and two clicks will sort the names Z-A).
All columns will sort in the order determined by the column chosen (e.g. the transaction will re-
main intact) (fig. 15).  You cannot sort in more than one order at a time.  For example, FECFile will
not sort all of the transactions for $200 on 4/5/99.  You can only choose one column for the sort.  In
addition, you can only sort information that appears in the View columns.  So, you could not
conduct a sort on the Purpose / Description that was entered for a transaction, because the informa-
tion is not displayed in the Disbursements View.

You have the ability to size the columns.  All columns can be made wider or narrower.  For further
explanation, refer to the Individuals/Organizations View.

There are four basic things you can do in the Disbursements View: itemize, clone, modify and
delete.

Itemize - If the year-to-date total of an individual or an organization is less than the FEC’s reporting
threshold, the transaction will automatically be counted as unitemized for transactions subject to
the itemization threshold.  By default, FECFile automatically categorizes disbursements as item-
ized or unitemized based on the year-to-date figures for the payee. There may be occasions when
you will want to itemize a transaction that would normally be below the threshold, or to unitmize
one that is over the threshold. To do this:

� Enter the disbursement into the system. If it is below the threshold, you will notice a
lower case “u” next to it in the Disbursements View.

� Single click on the disbursement  in the Disbursements View.

� Choose Itemize from the Edit menu.

fig.15



Page 40 Chapter 3

If the transaction was originally unitemized, it will now be itemized. If it was itemized, it will now
be unitemized.

Clone - This feature allows you to make copies of a disbursement  that has already been entered into
FECFile.  This is useful in cases such as paying monthly bills, or any other regularly occurring
disbursement.

� Select a previous disbursement to this vendor  from the Disbursements View.  (Items
are cloned from the Disbursements  View, not the Summary page View.)

� With the transaction highlighted, go to Edit on the menu bar and select Clone.  A copy
of the transaction will appear.

� Enter the current disbursement date.  If all the other information is the same, click OK.
If not, make any of the necessary changes in the appropriate fields.

Modify - This feature allows you to make changes to a disbursement that has already been entered
into FECFile.

� Select Disbursements from the View menu.

� Highlight the disbursement you wish to edit.

� Select Modify from the Edit menu.

� Click on the tab (Details, Endorsement, Event, Schedule F or Schedule H-2) that holds
the information you would like to edit.

� After you make the changes, click OK.  A prompt will ask you if you would like to
replace the object. Click Yes.  The changes will be made to the transaction after you
click Yes to replace the object.

NOTE - Remember if you need to change the address information of an entity, you make the
changes in the Individual/Organizations View.  A change made to the address information of an
entity will be carried to all transactions associated with that entity.

Delete - This feature allows you to remove disbursements that have been entered into FECFile.

� Activate the Disbursements View.

� Select the disbursement you want to delete from the Edit  menu. Choose Delete.  The
delete option will only be available if the transaction was entered in the current report-
ing period.  In other words, you cannot delete expenditures from a report that has been
filed. To remove previously reported transactions,  refer to the section on Amendments
in Chapter 7.

When a disbursement is deleted from the Disbursements View (except in the case of amendments),
the transaction will be completely removed from your file.  The only way to bring a disbursement
back into the file after it has been deleted is to reenter the transaction.
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Obligations

The Loans and Other Obligations View displays a history of all loans, debts and other obligations
a committee owes and is owed.  To activate the Obligations window, go to View on the menu bar
and select Obligations.

There are eight columns: Line#, Date, Individual/Organization, Amount, Description, Settlement/
Accrual, Accruals and Settlements (fig. 16).  This View can be sorted by any of the first five
columns.  If you click a column name once, the information is sorted one way.  If you click the
same column again,  the sort will be in the opposite order (i.e. One click on Individual/Organization
will sort the names A-Z and two clicks will sort the names Z-A).  All columns will sort in the order
determined by the column chosen (e.g. the transaction will remain intact).  You can not sort in more
than one order at a time.  For example, FECFile will not sort all of the transactions for $200 on 4/5/
99.  You can only choose one criteria for the sort.  In addition, you can only sort information that
appears in the View columns.  So, you could not conduct a sort on the Rate of interest that was
entered for a transaction, because the information is not displayed in the Obligations View.

You have the ability to size the columns.  All columns can be made wider or narrower.  For further
explanation refer to the Individuals/Organizations View.

There are six basic things you can do in the Obligations View: itemize, clone, repayment, (non-
cash) accrual, modify and delete.

Clone - This feature allows you to make copies of a loan or obligation that has already been entered
into FECFile.  This is useful if you have multiple loans and obligations with the same basic infor-
mation.  For example, if you have four loans from “The Tree Made of Money”, it might be time
efficient to enter one of the loans from the Summary page then clone the loan from the Obligations
View.

� Select the loan or obligation from the Obligations View.

� With the transaction highlighted, go to Edit on the menu bar and select Clone.  A copy
of  the transaction will appear.

� Enter the new loan or obligation amount.  If all the other information in the Item infor-
mation tab is the same, click OK.  If not, make any necessary changes in the
appropriate fields.

fig.16
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Repayment - To report a repayment of a loan:

� Activate the Obligations View.

� Select the loan or other obligation you wish to repay.

� Select Repayment from the Edit menu.

� Enter the Details (i.e. Amount, Date) of the repayment.

To report the addition of non-cash accrual to an existing loan or obligation, select the Obligations
View.  As with the repayment, the loan or obligation information must have been entered into
FECFile prior to entering a non-cash accrual.

To add non-cash to a loan or other obligation :

� Activate the Obligations View.

� Select the loan or other obligation you wish to accrue (non-cash).

� Select (Non-cash) Accrual from the Edit menu.

� Enter the Details (i.e. Amount, Date).

NOTE - Do not use (Non-cash) Accrual to accrue to a loan if the loan accrues cash.  A majority of
accruals are based on cash.  With these transactions you must increase your cash at the close of a
reporting period.  Data entry for these is as for new loans.

Modify - This feature allows you to make changes to a loan or obligation that has already been
entered into FECFile.

� Activate the Obligations View.

� Locate the transaction you wish to modify.

� Select Modify from the Edit menu.

� Click on the tab (Details, Endorsement or Schedule C-1) that has the information you
would like to edit.

� After you make the changes, click OK.  A prompt will ask you if you would like to
replace the object. Click Yes.  The changes will be made to the transaction after you
click Yes to replace the object.

NOTE - Remember if you must change the address information of an entity, you make the changes
in the Individual/Organizations View.  A change made to the address information of an entity will
be carried to all transactions associated to that entity.
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Delete - This feature allows you to remove loans and obligations that have been entered into FECFile.

� Activate the Obligations View.

� Locate the obligation you wish to delete.

� Select Delete from the Edit menu.

The delete option will only be available if the transaction was entered in the current reporting
period.  In other words, you cannot delete loans and obligations from a report that has been filed.
To remove previously reported transactions, refer to the section on Amendments in Chapter 7.
When an obligation is deleted from the Obligations View (except in the case of amendments), the
transaction will be completely removed from your file.  The only way to bring the obligation back
into the file after it has been deleted is to reenter the transaction.

NOTE - To edit, clone or delete a transaction reported on an H or H2 Schedule, you must go to the
Obligations View.  The H2 schedule shows allocation ratios for shared federal and nonfederal
activity, including individual fund-raising events, exempt activities, and direct candidate support.
The H1 Schedule shows the method of allocation for shared federal and nonfederal administrative
expenses, and generic voter drive costs.

Validator

The Validator View verifies that all transactions meet the standards of the electronic filing format.
To activate the Validator window, go to View on the menu bar and select Validator.  When you
activate this View, FECFile calls on a tool called FECheck.  You might hear someone refer to it as
FECheck, which is the same as the Validator View in FECFile.  Performing the validation is neces-
sary to ensure that your report is complete and that it will not be rejected by the FEC’s electronic-
filing server when you upload your filing. The FEC will run the same validation on your file before
it can be accepted.  The vaildator does not check your report for compliance with the FEC.  The
compliance responsibility remains with you.  The Validator is primarily looking for structural er-
rors and common missing information (for example, the Treasurer’s signature date or a candidate’s
office, state and district information).

fig.17
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The Validator View is different from the 7 other Views.  The program FECheck evaluates the data
which is contained within the open report.  The results of FECheck’s evaluation are displayed in the
Validator View (fig. 17).  You do not have the ability to sort, re-size columns or make changes
within this View.  However, the Validator View is the only View that can be printed.  If you want
to print the Validator View, Go to File on the menu bar and select Print.

Reading Validation Results

Validation Summary - At the top of the validation screen you should see a line that reads “Valida-
tion Summary : 0 error(s), error level = 0”.  If a zero is associated with the number of errors, this
means your report has no structural errors, and your report can be uploaded electronically.  How-
ever, if the report has errors there may be some corrections required before you can file the report.

MD5 checksum - The second line of the validation screen is the MD5 checksum.  The checksum
number is your proof that nothing was changed in your file during the upload to the FEC.  This
number is automatically generated by FECFile, and will look something like this:
MD5 checksum = 2b86c8d82ec39d670fl678f284b06b26.  If you change anything on this report,
the checksum will change (even if you add a space).  If you are uploading a filed report, you should
note this number (perhaps by printing the Validator View).  When you receive your confirmation
from the FEC (by FAX and/or e-mail), match it against the checksum sent to you by the FEC.  It is
important to remember that if you change anything on the report in FECFile, the checksum will be
different.  This does not mean, however, that after you file that report and begin the next report the
numbers will change.  After you have filed your report (with a Filed on date), that information is
locked into your report history.

Software name and Version number - The third line has the name of the validator  (FEC File
Validator) and the version number.

Error Descriptions - If you have errors in your filing, there will be a section that has four columns
(FORM NAME, ERR LVL, COL # and DESCRIPTION).  This section will be located between the
double dotted lines.

FORM NAME - Will always begin with an F, short for form, or S, short for Schedule.  After the F,
you will see the type of form you are using 3, 3X or 6.  If you are not sure of the form type, contact
the Federal Election Commission.  If you believe the wrong form type is displayed, contact the
software’s technical support.

ERR LVL - There are five possible error levels you may see: 4, 6, 8, 12 or 16.  You must correct
errors with ERR LVL = 8 or higher.  Reports with ERR LVL greater than or equal to 8 will not be,
accepted by the electronic filing system.  Although reports with ERR LVL less than 8 will be
accepted by the FEC server, you are encouraged to correct all errors before uploading a report.

COL # - This is the offending field number in the .FEC format.  A FECFile user would most likely
not be concerned with the information in this column though it may prove useful to technical
support staff.

DESCRIPTION - This column helps you to locate the specific transaction with a problem.  If a
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transaction has more than one problem, multiple error messages will be generated (each problem
will have an error).   For detailed  information on validation errors, see Appendix III.

Review - Chapter 3

1 A file can, and in most cases should, contain multiple reports. Do not create a new file for each
new report. Your YTD numbers and individual aggregates will not be correct.

2 The View menu gives you access to data.

3 Most data entry is done through the Summary page View.

4 Existing information can be edited from the corresponding View by choosing Modify form the
Edit menu.

5 Most Views can be sorted by clicking on the appropriate column header.

6 The Validator View is different from the other Views  in that it displays information, but there
is no data entry or modification ability associated with it.

7 Use the Lookup feature whenever  you are creating a new entry for a Federal Committee. This
ensures accuracy and provides information you might not otherwise have.

8 Download the Committee Lookup file when prompted to keep it current.
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Creating or selecting a report

If you have walked through the steps outlined in Chapter 2 for getting
started, you have created a report and should skip to the “Entering
Transactions” section below. To select an existing report, choose View
from the menu and select Reports. Select the report you are currently
working on from the reports list. Even if you are just beginning to use
FECFile, it is possible that you will have more than one report on the
reports list. If the coverage dates of your first electronic report do not
include January 1st of the current year,  and you have reported trans-
actions in a prior period this year, you must create a “dummy” report

that begins with Jan. 1 and ends with the day before your report begins. In this report you will enter
data from all previous reports since the first of the year. See Chapter 2 for details about adjusting
aggregates.  If you have not yet created a report, choose New from the Edit menu and follow the
steps in Chapter 2, beginning with step 4, “Type of new report”. The software remembers the last
report you were working on and automatically selects it. If you are not allowed to enter data, you
have probably selected a report that has been filed (or at least has a filing date entered into the report
details screen). In this case, select the correct report or remove the filing date by choosing File
Report from the Edit menu and deleting the date. It is not advisable to remove the Filed on date
from a report that has actually been filed with the FEC as this makes it possible to accidentally
change information and render your historical record, and possibly future amendments, incorrect.

Entering Transactions

With a few exceptions, such as importing and cloning, which will be addressed later, nearly all
transaction entry begins with the Summary page View (choose Summary page from the View
menu). The summary is a combined representation of information from the Report of Receipts and
Disbursements and the Detailed Summary page. Form 3 and Form 3x are similar; they differ in the
line numbers used to display information. In this text, references to line numbers will be given in
the following  format:

“Line” ( Form 3x/Form 3) - Description

For example:  Line 15/14 - Offsets to Operating Expenditures.

This indicates line 15 for form 3x and line 14 for form 3.

The software selects Form 3 or 3x based on the committee type you specified when creating your
file and displays it in the Summary page View.
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Correctly entering a transaction involves following a simple two-step process.

� Determine the line number for the transaction. If you don’t know the line number,
consult your Campaign Guide or other FEC references.

� Once you have determined the line number, double click on that line in the Summary
View and enter the information for the transaction.  The process is the same for all
transaction types though the detailed information may be different and more complex
transactions (such as loans and debts) may have extra data entry screens.

Most transactions share a common data entry screen we will refer to as the Item Information Screen.
It has a number of  fields;  Date, Amount and Individual/Organization are always required; Election
and Description/Purpose  are sometimes required; and Memo, which should not be checked unless
directed to do so in the “Special Transaction Types” chapter .  There may be extra tabs at the top of
the screen that require further information for certain transaction types. These tabs will be de-
scribed in detail below.

Cash on Hand (Jan. 1)

Line 6a/23

� Activate the Summary page
View and double click on the appro-
priate line (Form 3, line 23, or Form
3X, line 6a).

When you double click on the line
number, the Item Information tab will
appear (fig. 1).

�  Enter the first day of the cov-
erage period (for example, if your com-
mittee began filing with the FEC a re-
port that covered January 1, 1999, you
should enter 1/1/99).  In the amount
field, enter the amount of cash on hand
at the beginning of the reporting pe-
riod.

The Individual/Organization field will be grayed-out since it is not applicable.  In addition, you can
ignore the Description / Purpose field and the Memo check box.  If you chose to enter a Description
/ Purpose, the information will not be sent to the FEC since the transaction does not generate a
schedule.  Only the amount will appear on the FEC form 3, line 23, of the Detailed Summary page
and on the Summary Page Line 6(a), for Form 3X.

� Do not check the memo box! If you check the memo box, the amount entered will not
be accounted for in your Summary and Detailed Summary pages of your FEC report.

fig. 1
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There are only rare occasions when this box is checked.  If the box is checked you will see
MEMO in the Line# column of the Opening Cash View.

Transactions

The data entry for the following four lines is the same. The line numbers are the same for both Form
3 and Form 3x, with the exception of line 11(d), which is available in Form 3 only.

LINE 11(a) - Individual Contributions (other than loans)
LINE 11(b) - Contributions from Political Party Committees (other than loans)
LINE 11(c) -  Contributions from other Political Committees (other than loans)
LINE 11(d) - Contributions from the Candidate (other than loans) (Form 3 only)

Double click on the line that is correct for the transaction you wish to enter. In the item information
screen, enter the Date and Amount. Choose or enter the Election (Primary, General etc.) if it is
required. To assign the contribution to a person, either select an existing individual from the scroll-
ing Individual/Organization list or add a new one by right clicking on the list. From this point, the
steps are the same as those outlined in the “Adding New Individuals and Organizations” section in
this chapter.

In most cases an ordinary receipt requires no description, but if one is required, enter it in the
Description/Purpose field. The Memo box and the Endorsements tab are used for specific types of
contributions and are described in the “Special Transaction Types” section in this chapter.

LINE 12/12  - Transfers
This line is the same on both Form 3x and Form 3. Follow the procedures outlined for Line 11
above.  In the Individual/Organization box, choose or enter the Committee that is transferring the
funds.

LINE 13/(13a or 13b) - Loans
Though the procedure for loans is the same as for contributions, more information is required, so
there are several more steps in the data entry process.

� Double click on the correct line for the loan (Form 3x reports all loans on line 13. Form
3 differentiates between Loans made/Guaranteed by the Candidate, reported on line
13a, and All Other Loans, reported on line 13b.)  The initial screen is the Item Informa-
tion screen.

� Enter the Date, Amount and Election as described for line 11 above.

� Assign the lending institution or individual making the loan in the Individual/Organi-
zation scroll box as described above.

� Enter a description if required, but do not check the Memo box.

From this point, the data entry is unique to loans.
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� Choose the Endorsements tab (fig.
2). Because a single loan may have mul-
tiple guarantors, a scrolling list is provided
from which you may choose all guarantors
associated with a particular loan.

� Select  guarantors (if any) by double
clicking on each one on the scrolling list.
If they do not exist on the list, right click
on the list and create them. Once they have
been created, double click on them.

When all the guarantors are listed in the
bottom box, it is necessary to assign the
amount guaranteed by each guarantor.

� Double click on each guarantor in
the lower box and enter the amount of the guarantee.

� Enter the Due date of the loan and check the Secured box, if required.

The schedule C1 tab contains information that would be printed on a schedule C1 report (fig. 3).

� Select the lending institution
from the list (or right click and add it if
it is not there).

� Enter the value and description
of traditional collateral pledged, if any.

� If the lender has a perfected se-
curity interest in the collateral, check
the Perfected Interest box.

� If future income is pledged, in-
dicate the value and description and
select or add the bank where the ac-
count is held and the date it was cre-
ated.

� If there is an alternate basis for
loan repayment, describe it in the area
provided.

LINE 14/none - Loan Repayments Re-
ceived (Form 3x only)
Line 14 on the Form 3x Summary page

fig. 2

fig. 3
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View is for display only. Double clicking on it does nothing. To enter a Loan Repayment received,
there must first be a loan made.

� Create Loan ( See “Line 27 - Loans Made” for details. )

Once a Line 27 entry has been made, Payments Received may be entered from the Obligations
view.

� Choose Obligations from the View Menu.

� Right click on the Loan for which payment has been received and choose Repayment.

� Enter the information in the item information screen.

By entering the data through the Obligations view, the payment is associated with the loan and
the amount of the repayment is reported on schedule C and the outstanding balance is reduced
appropriately.

LINE 15/14 - Offsets to Operating Expenditures (including refunds, rebates, and returns of
deposits)
Offsets are entered exactly like Line 11 contributions. Double click on the Line 15/14 and follow
the data entry steps described in the Line 11 section.

LINE 16 - Refunds of Contributions made to other Federal Candidates and Committees -
(Form 3x only)
Line 16 refunds are entered in the same manner as Line 11 receipts. Double click on Line 16 and
follow the data entry outlined in the Line 11 section.

LINE 17/15 - Other Federal Receipts/Other Receipts (including dividends and interest)
Double click on the line (17 for Form 3x and 15 for Form 3) and enter the data as for Line 11,
described above.

LINE 18 - Transfers from Non-federal
Account for Joint Activity
Line 18 displays information that is de-
tailed on schedule H3. To begin with, the
data entry is the same as for a Line 11 re-
ceipt.

� Enter the date and amount and
account information (in the Individual/
Organizations box); then select the En-
dorsements tab.

In this case, the endorsements section al-
lows you to assign subtotals of the trans-
fer to different events or activities (fig. 4).

� Select an event from the list or

fig. 4
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add it if it does not yet exist (right click on the list).

� Once the event or events have been added, double click on each one and add the amount
allocated for that event and select whether it is a Direct Fund-raising Activity or Exempt Activ-
ity/Direct Candidate Support.

LINE 21(a) - Allocable Expenditures  (Form 3x only)
Allocable expenditures (Schedule H4) are
entered by double clicking on line 21a.

The Type of allocable expenditure screen
presents six options (fig. 5) . The first three,
Administrative / Generic Voter Drive,
Fundraiser and Exempt Party Activity
place the transaction entirely on line 21a.
Choosing Direct Candidate Support places
the Federal share of the disbursement on
schedule B, for line 23. Selecting Indepen-
dent Expenditure places the Federal share
on Schedule E for line 24 and Choosing
Coordinated Party Expenditure places the
Federal share on schedule F for line 25.
For the first four types, the item informa-
tion screen is the same. (fig. 6)

� Enter the Date, Amount and Non
Federal Share.

� In the Individual/Organizations
box, select or add (right click) a record
for the place where the money was
spent.

�  Describe the transaction in the
Description/Purpose field.

� If there is an event associated
with this disbursement, choose the
“Events” tab and select from the event
list or add to it the joint activity to which
the expenditure is related (fig. 7).

� When adding an event, select
Event (Joint Federal/Non Federal) from
the record type list.

� Be sure to include the event date on the Special tab.

Choosing Independent Expenditure opens a different Item Information screen that includes an En-

fig. 5

fig. 6



Page 52 Chapter 4

dorsements tab (fig. 8).

� On the Endorsements tab, select
the Candidate Beneficiary (or right click
to create a new  one) from the Candidate
Beneficiary box. When creating a new
Candidate Beneficiary record, Choose
Candidate from the  Type screen.

� Check the Oppose box if the ex-
penditure opposes the selected Candi-
date. Leave the box unchecked to indi-
cate support.

Choosing  Coordinated Party Expenditure  opens yet another different Item Information screen
containing an  Endorsements tab and a Schedule F tab.

� On the Endorsements tab (fig.
8), select the Candidate Beneficiary (or
right click  to create a new  one) from
the Candidate Beneficiary box. When
creating a new Candidate Beneficiary
record, Choose Candidate from the
Type screen. The Oppose check box
will be unavailable and is not applicable
to schedule F.

� Choose the Schedule F tab (fig.
9) and select or create the Designating
and Subordinate committees in the
boxes provided. Enter the year of the
general election.

LINE 21(b)/17 - Other Federal Operating Expenditures/Operating Expenditures
Entering an Operating Expenditure is much like entering a receipt. The screen is simple and, in
most cases, requires no supporting information.

� Enter the Amount , Date and the Election if required.

� Select the recipient from the Individual/Organizations list or right click on the list to
add a new entry.

fig. 7

fig. 8
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Unlike most  receipts,  Operating Expenditures do require a purpose of expenditure.

� Enter the purpose in the De-
scription/Purpose field.

The Memo box should remain unchecked
unless the transaction is one of the special
transaction types that require it. The en-
dorsement tab is also only necessary in spe-
cial situations. See the “Special Transac-
tion Types” section in this chapter for more
information on these transactions.

LINE 22/18 - Transfers to Affiliated/
Other Party Committees/Transfers to
Other Authorized Committees
Transfers are entered for line 22/18 in the
same manner as Operating Expenditures.
Double click on the appropriate line and
enter the Date, Amount, Election (if appli-
cable), Committee Information and Purpose. Leave the Memo box unchecked.

LINE 23 - Contributions to Other Federal Candidates and Political Committees (Form 3x
only)
Contributions to other federal candidates and political committees are entered following the same
procedures as for Operating Expenditures. Double click on line 23 to begin.

LINE 24 - Independent Expenditures (Form 3x only)

The primary data entry screen for Line 24 Independent Expenditures is the same as that for Operat-
ing Expenditures, and the information is entered in the same manner.  The Endorsements tab,
however, is different (fig. 8). If the independent expenditure is related to a Schedule H4 expendi-
ture, it will be created as part of the data entry process for schedule H4 and should not be created
manually.

� Select the committee that is affected by the expenditure.

� Check the Oppose box if the expenditure is made in opposition to the committee.

If you do not check the box, the expenditure is assumed to be in support of the committee.

Transactions reported on line 24 generate a corresponding Schedule E. Though the infor-
mation is transmitted to the FEC with the electronic filing, the requirement that Schedule
E be notarized and sworn to under penalty of perjury, requires the filer to submit the actual
form on paper to the FEC.

fig. 9
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LINE 25 - Coordinated expenditures (Form 3x only)

Like independent expenditures, coordinated expenditures are entered in the same screen as Operat-
ing Expenditures.  If the coordinated expenditure is related to a Schedule H4 expenditure, it will be
created as part of the data entry process for schedule H4 and should not be created manually.

� Enter the Date, Amount and Election.

� Select or add the vendor or recipient of the payment in the Individual/Organizations
box.

� Enter the transaction purpose in
the Description/Purpose field.

The information on the Endorsements tab
varies slightly from that in the line 24 en-
dorsements tab in that the check box that
indicates support or opposition is grayed
out (fig. 10)..

� Select the Candidate Benefi-
ciary from the list or add a new one by
right clicking in the box.

Choose the Schedule F tab (fig. 11).

� Single click on the designating
committee in the scrolling list. In the
Designating Committee scrolling list,
indicate the candidate supported by this
expenditure. This must be the Candi-
date not the Candidate’s campaign
committee. If the candidate has not yet
been added to the list, right click on the
list and follow the steps to add it. It is
best to use the Lookup feature as this
automatically includes the state and
office sought, required for schedule F.

� Select or add the Subordinate
committee in the Subordinate Commit-
tee scrolling list and enter the year of
the general election.

LINE 26/19(a,b,c) - Loan Repayments
(made)

Loan repayments are displayed in the

fig. 11

fig. 10
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Summary page View but the data entry is not done from this screen. Because the repayments must
be associated with the original loans on schedule C for balance calculations, the data entry requires
that you:

� Select Obligations  from the View menu.

� Right click on the loan for which a payment is being  made and choose Repayment.

Note that the loan was designated as a loan from the candidate or other loan (Form 3 only) when it
was made and that information carries forward to the payment.

� Enter the Date, Amount, Election information and Purpose as required.

� The individual or organization that made the loan should already be selected on the
scrolling list.

� Do not check the Memo box.

LINE 27 - Loans Made (Form 3x only)
To enter a loan made by your committee, double click on line 27 (Form 3x only) and enter the
information in the Item Information screen. There are no other related tabs or screens for these
transactions. See Line 14 for repayments of loans made.

LINE 28a,b,c/20a,b,c - Refunds of Contributions To
Double click on the correct line number for the type of contribution being refunded and enter the
details in the Item Information screen.

LINE 29/21 - Other Disbursements
Double click on the Other Disbursements line and enter the detailed information in the Item Infor-
mation screen.

C9 - Loans Owed TO the Committee
This line is for display purposes only. The actual loans are entered on line 27 (See above).

D9 - Other Debts Owed TO the Committee
To enter a debt owed to the committee, double click on this line on the Summary Page View. Enter
the specific information in the Item Information screen and Choose OK. To enter a payment on a
debt owed to the committee, choose Obligations from the View menu. Find the debt for which
payment has been received and single click on it. Choose Repayment from the Edit menu. Select
the type of repayment from the Type of Deferred Receipt screen and choose OK. Enter the specific
information for the repayment.
C10 - Loans Owed BY the Committee
This line is for display purposes only. The actual loans are entered on line 13 (See above).

D10 - Other Debts Owed BY the Committee
To enter a debt owed by the committee, double click on this line on the Summary Page View. Enter
the specific information in the Item Information screen and Choose OK. To enter a payment on a
debt owed by the committee, choose Obligations from the View menu. Find the debt for which
payment has been made and single click on it. Choose Repayment from the Edit menu. Select the
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type of repayment from the Type of Deferred Disbursement screen and choose OK. Enter the spe-
cific information for the repayment.

Method of Allocation for Shared Expenses (H1)
To create a schedule H1, double click on Method of Allocation for Shared Expenses (form 3x only)
to open the Item Information screen. (fig. 12) Click on the radio button that corresponds to your
committee. Your choices are:

1. National Party Committee

2. House / Senate Campaign Committee

3. Non-Connected Committee / SSF

4. State / Local Party Committee

Fill in the information required for your committee. If you choose State / Local Party Committee,
click on the Ballot tab and check the boxes that apply to you.

Allocation Ratio for Joint Activity (H2)
To create an entry for schedule H2:

� Double click on the Allocation
Ratio for Joint Activity line at the bot-
tom of the Form 3x Summary Page
View.  The  Item Information  screen
appears. (fig. 13)

� Enter the Non Federal percent-
age for the event.

� Select the correct election (Gen-
eral, Primary, etc).

� Select the event from the Name
of Event list. If the event has not been
entered into the system, create it by right
clicking on the list. Choose Event from
the Type list and enter the details on the
Details tab. You must enter the date of
the event on the special tab.

Select the Schedule H2 tab. Indicate the type of the activity (Fundraising, Exempt or Direct
Candidate Support) and whether the ratio is New, Revised or Same as previously reported.

If you make a mistake creating an entry for Schedule H2, you may edit or delete H2 entries
by choosing Obligations from the View menu. Double click on the item you wish to edit or
single click and press the delete key to delete.

fig. 12
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General Data Entry

you will find that the data entry procedure for almost all transactions is similar in nature and be-
comes quite instinctive. Occasionally you may be required to report a transaction with which you
are not familiar. The first step should always be to consult the Campaign Guide for instructions on
how to report the transaction. Once you determine the line number and any other special reporting
requirements, go to the Summary page View and double click on the appropriate line. If  you cannot
determine the data entry procedure for a given transaction, call the technical support line listed in
Chapter 1.

Printing and Previewing a Report

Though FECFile 3 is primarily designed as an electronic filing tool, there are times when it is
advantageous or even required to create a printed report.  The preview function is handy for quickly
checking data entry in a format that is familiar to most filers, and printing a report can be a comfort-
able way to check the accuracy of a report before filing. Many committees are required to submit a
copy of their FEC report to State agencies. Though this requirement is in the process of  being
phased out, it is still important to be able to create the printed reports when necessary.

To preview a report,  select Preview from the File menu or click on the Preview button .  The

entire report will be presented on screen. Use the scroll bar on the right to scroll through the report.

To print the report, choose Print from the File menu. The default setting is to print the entire report.
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To do this, choose OK. To print a single page or a group of pages, click on the Pages button and
enter the starting and ending page numbers you wish to print.

Reviewing a Report Electronically.

Because a filed report can easily be read and manipulated in a spreadsheet, it makes sense to use
your spreadsheet to review or evaluate a report before filing. Perhaps other people in your organi-
zation would like the opportunity to check the report before filing. While this can be done by
printing the report, as outlined above, it is more efficient to use a spreadsheet.  The first step is to
file the report to a diskette. This process is described in Chapter 6 and can be done without offi-
cially filing the report with the FEC.

Once you have the report on diskette, it can be treated like any other data file. Remember, that it is
a comma delimited file. When you open it in most spreadsheet programs, you must indicate that the
file is delimited and that it is delimited by commas (as opposed to Tabs, another common delim-
iter).  After opening the file, it will appear and behave like any other spreadsheet file and may be
sorted or filtered as you wish.
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Review - Chapter 4

1 After filing a report, create the next report from the Reports View by choosing New from the
Edit menu. Do not choose New from the File menu as this will create a new file, and the new
report will not have access to totals from the previous report!

2 Most transactions are entered from the Summary Page view by double clicking on the correct
summary line for the transaction.

3 Some transactions require extra information, and special screens and procedures are provided.
Loans, debts, independent expenditures, coordinated expenditures and joint activity transac-
tions are examples of transactions requiring extra information.

4.   Transactions may be edited  by selecting the appropriate View from the View  menu and double
clicking on the item to be edited.

5 Specific rules and regulations can be found in the Campaign Guide for your committee type.
These guides are available from the FEC or can be downloaded from the FEC website.

6 Reports may be previewed or printed in the familiar FEC format by choosing File and Print or
clicking on the Print icon.
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�5Special Transaction Types

There are certain transactions that require extra information or special report-
ing procedures. Most of these are reported on standard forms, such as Sched-
ule A, but must be explained more thoroughly or documented to a greater
degree. In electronic filing, these transactions are reported in ways that are,
for the most part, analogous to paper filing. For official descriptions and re-
porting requirements for these special transactions, refer to the FEC Cam-
paign Guide for your type of committee.

Memo Transactions

Memo Transactions are transactions that are included for clarity and to provide detailed informa-
tion.  One example of a memo transaction would be a partnership where the partners’ contributions
are listed as memo contributions  and the partnership contribution is not a memo. If all were non-
memos, the total for line 11ai would include double the actual partnership contribution amount.
Another example is a Schedule H4 disbursement for direct candidate support. The single disburse-
ment must be listed on Schedule B, line 23 as an actual disbursement for the Federal share. Memo
entries for the candidate beneficiaries are listed on Schedule B, line 23 as well. In some cases, such
as the partnership example, the memo items are created as a part of the data entry process and you
are not required to create them manually. In others, such as the Schedule H4 example,  you must
create the memos on Schedule B, line 23 manually. Creating a memo transaction is the same as
creating an actual transaction, with the added step of checking the memo check box on the Item
Information screen.

In-Kind Contributions

In-Kind Contributions (received)
An in-kind contribution received by your committee is reported by entering  two transactions  into
FECFile.  It is important to enter an  in-kind contribution received on both  Schedule A, and  Sched-
ule B so as not to inflate the cash-on-hand. Enter the receipt on the appropriate line of the Summary
page View.  Enter a disbursement on line 21b (other federal operating expenditures) of the F3x
Summary page View or line 17 (operating expenditures) of the F3 Summary page View.

For each in-kind contribution (received and made),  you must  enter:
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� The Date of the receipt/disbursement.

� The Amount.

� The Election (if required).

� The Name and Address of the contributor/payee.

� The Description / Purpose of the in-kind transaction.

Example: In-kind contribution received:
John Brown gave an in-kind contribution to the Blue PAC.  He donated a video camera worth $900
on 3/2/2000.  (Assume you have already created and activated the report that covers 3/2/2000 in
your file.)  How would the Blue PAC report this contribution?

1. Activate the Summary page View.

2. Double click on line 11a (individual contributions).

3. Enter 3/2/2000 in the Date field. Press tab.

4. Enter $900 in the Amount field.  Press tab.

5. Enter the Election by typing the first letter (i.e., G for General, P for Primary, etc.).
*Remember, SSFs leave this field blank.

6. Select Brown, John from the Individual/Organization list.  If he is not on the list, right
click on the list and create a record for him.

7. Type “in-kind, video camera ” in the Description / Purpose field. Choose OK.

To create the disbursement that balances the IN-Kind contribution:

8. Double click on line 21b (other federal operating expenditures) or line 17 (operating
expenditures) from the Summary page View.

9. Enter 3/2/2000 in the Date field. Press tab.

10. Enter $900 in the Amount field. Press tab.

11. Enter the Election by typing the first letter (i.e. G for General, P for Primary, etc.).
*Remember SSFs leave this field

12. Select Brown, John from the Individual/Organization field.  If he is not on the list, right
click on the list and create a record for him.

13. Type “in-kind, video camera” in the Description / Purpose field.

14. Click OK.

In-Kind contributions (made)
An in-kind contribution made by your committee is entered into FECFile as a single transaction.

Example: In-kind contribution made:
The Howard Committee made an in-kind contribution of a photographer for a dinner on 5/2/2000,
organized by The George Committee.  The service was worth $400.  (Assume you have already
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created and activated the report that covers 5/2/00 in your file.)  How would the Howard Commit-
tee report this disbursement?

1. Activate the Summary page View.

2. Double click on Operating Expenditures .  This will be line 21b of Form 3X or line
17 of Form 3.

3. Enter 5/2/2000 in the Date field. Press tab.

4. Enter $400 in the Amount field. Press tab.

5. Enter the Election, if required, by typing the first letter (i.e. G for General, P for Primary
etc.).

6. Select The George Committee from the Individual/Organization field.  If the committee
is not on the list, right click on the list and create a record for it.

7. Type “in-kind made, photographer” in the Description / Purpose field.

8. Click OK.

Earmarked Contributions

An earmarked contribution must be reported by both the conduit and the recipient authorized com-
mittees.

Report by Conduit
A political committee that serves as the conduit of an earmarked contribution must disclose the
earmarked contribution regardless of amount.  The conduit must comply with special reporting
rules, which vary depending on whether the contribution was deposited in the conduit’s bank ac-
count, or was passed on directly to the campaign in the form of the original contributor’s check.

Schedule A (receipt)

1. Date the contribution was received by the conduit.

2. Amount of the earmarked contribution.

3. Election for which the contribution was designated.

4. Individual/Organization information (i.e. name, address, employer, occupation).

5. Candidate designated by the contributor as the recipient “Earmarked to Jay Smith for
Congress, AL 03”.  (This information should be entered in the Purpose / Description
field.)

6. If the contribution was not  deposited in the conduit’s bank account, check the Memo
checkbox.
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Schedule B (disbursement)
Once the committee forwards the contribution to the candidate, the committee must report the
disbursement of the funds on a Schedule B, for the correct line number for the transaction type.

1. Date the contribution was forwarded to the candidate.

2. Amount of the earmarked contribution.

3. Election for which the contribution was designated.

4. Candidate that received the contribution (in the Individual/Organization field).

5. Name of the contributor in the Purpose / Description field.

6. Candidate designated by the contributor in the Purpose / Description field.

7. The words “earmarked contribution” in the Purpose / Description field.

8. If the contribution was not  deposited in the conduit’s bank account, check the Memo
checkbox.

Report by the Recipient Committee
The recipient of an earmarked contribution also has a reporting obligation. The recipient enters the
transaction into FECFile as follows:

1. Double click on line 11a in the Summary page View.

2. Enter Date of receipt of the earmarked contribution from that conduit.

3. Enter the total Amount of earmarked contribution from that conduit.

4. Include the Election for which the contributions were designated.

5. Select the Name of the Conduit committee from the Individual/Organization drop-down
list.

6. Type “earmarked contribution” in the Purpose / Description field.

7. Click on the Endorsement tab.

8. Double click on the names of the Individuals whose contributions are included in the
conduit contribution (if they are not on the list, add them).

9. The names of the individuals that were selected  appear in the second box.

10. Double click on the names in the second box.

11. Enter the individual’s share of the earmarked contribution.

12. Click OK.

13. Repeat steps 10 and 11 for each contributor represented in the conduit contribution.

14. Click OK.
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Note - All of the names selected in the Endorsements tab will be Memo items, and will not inflate
the totals for the report.

Reattributions

1. The entire amount of the original contribution should be entered into the program (if it
has already been created, don’t enter it again) by double clicking on the appropriate line
of the Summary page View (most likely line 11a).

2. Fill in the Date, Amount, Election, etc.

3. Create another contribution on the same line, for the same person, using the reattributed
amount as a negative number (cloning the original transaction will save time and ef-
fort) .

4. To indicate that the transaction is a reattribution, type “Reattribution” in the Descrip-
tion field.

5. The third transaction is on the same line as the other two, and is a positive contribution
for the reattributed amount.

6. In the Individual/Organization box, select the person to whom the amount is being
reattributed.

7. In the Description field, indicate that the transaction is a Reattribution.

Redesignations

To redesignate a contribution (Schedule A) to a different election:

1. Enter the original contribution into the system. If it already exists, don’t create another
one.

2. From the Receipts View, right click on the contribution to be redesignated, and choose
Clone.

3. Change the date of the cloned contribution to the date of the redesignation, and the
amount to the negative of the amount you wish to redesignate.

4. In the Description/Purpose field, indicate that this is a redesignation and note the date
of the original transaction.

5. Close and save this transaction.

6. Right click on the newly cloned transaction and choose Clone again.

7. This time change the reporting period to represent the election that the transaction is
being redesignated to. Change the Amount from negative to positive.  Close and save
the transaction.

To redesignate a contribution to another committee (Schedule B) to a different election:
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1. Enter the original disbursement into the system (Form 3x, Line 23). If it already exists,
don’t create another one.

2. From the Disbursements View, right click on the disbursement to be redesignated, and
choose Clone.

3. Change the date of the cloned disbursement to the date of the redesignation, and the
amount to the negative of the amount you wish to redesignate.

4. In the Description/Purpose field, indicate that this is a redesignation and note the date
of the original transaction.

5. Close and save this transaction.

Credit Card Payments

Reporting disbursements that were made via credit card requires an entry for the payment to the
credit card company and individual memo entries for each purchase made with the credit card.

Operating Expenditures
1. Report the payment to the credit card company on the appropriate line (17 for Form 3,

21b for Form 3x).

2. Enter the Amount, Date, Election, and Purpose for the payment to the card company.

3. Click on the Endorsements tab. Find each vendor on the list of organizations and add
it to the list below by double clicking. If a vendor is not on the list, right click on the
box and create an entry for it. Once the vendor record is created, double click on it to
add it to the lower list.

4. Double click on each vendor in the lower list box an enter the Date, Amount, and Descrip
tion of the actual purchase.

On the report, the payment to the credit card company will be reported as a disbursement followed
directly by memo entries for each separate credit card purchase.

Credit Card Payments for Schedule H4
If the payment is related to an allocable shared activity, and as such is reported on schedule H4, the
procedure is different.

� The payment to the credit card company is made in the full amount of the payment
as described for line 21a.

� The individual purchases are entered on line 21a also, but the Memo box must be checked
and the word Memo should be included, along with the description of the purchase, in
the Description / Purpose field.
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Payroll Deductions

Payroll deductions (contributions to the committee made via payroll deduction) are reported on
schedule A, line 11a. Unlike other contributions, they require extra information in the Description
/ Purpose field.

� The words “Payroll Deduction” should appear with an indication of the frequency and
amount of the deduction such as “bi-weekly $25”.

While payroll deductions may be reported as separate transactions, they may also be combined. For
example, Marie Jones may contribute $25 by payroll deduction six times during a reporting period,
and the deductions may be reported as $150 on the day of the last payroll deduction with a Descrip-
tion line entry “Payroll Deduction $25 bi-weekly.”

Payroll deductions may be entered into FECFile three different ways:

� Importing - If the information is received on a regular basis from an accounting office in
an electronic format, it may be possible to import the information each time it is re-
ceived.

� Cloning - If the number of payroll deduction contributions is not too great, cloning
can be used to speed up the manual data entry process.

To clone a transaction, go to the View that displays that transaction, in this case the Receipts View,
and right click on the transaction and choose Clone. This will create an instant transaction that is
identical to the one selected on the screen. You must then change any information that is not the
same as the previous one, such as the date and perhaps the amount. This method works well if there
are not too many transactions.

� Individual Transactions - Payroll deductions may also be entered one at a time like any
other contribution but with the availability of cloning, however this option is clearly not
the most efficient method.

Exempt Legal and Accounting Fees

Exempt legal and accounting fees should be entered on Line 11a. From the Summary page View,
double click on Line 11a and enter the correct Date, Amount, and Election information. In the
Description field, enter “Exempt Legal Fees” or “Exempt Accounting Fees” and check the Memo
checkbox. It is important to check this box to prevent the amount from appearing in the summary
in the Line 11a totals.

Partnership Contributions

Partnership contributions must be entered so that the entire amount of the contribution is listed as a
receipt and the contribution of each partner is listed separately as a Memo entry.

� Double click on line 11a on the Summary page View, and enter the date received, the
total amount of the contribution, the election, and select or add the partnership in the Indi-
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viduals/Organizations box (see Chapter 4 for details).

� Click on the Endorsements tab (fig. 1).

Each of the partners that participated in this contribution must be added to the endorsements list.

�  If the partners are
already on the list, double
click on each one to add
them to the box below the
list. If a partner has not yet
been added to the list,
right click on the list and
create an entry. Double
click on newly entered
partners to add them to the
box below the list.

Once all the partners have
been added to the box, you
must indicate the amount they
are each responsible for.

� Double click on
each partner in the lower
box, and enter the correct
amount in the a m o u n t
field of the Subitem Infor-
mation screen.

The partnership contribution will be reported as a receipt and the partners’ contributions will be
reported as memo entries.

fig. 1
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Review - Chapter 5

1 In-kind Receipts require entry of the receipt and a corresponding disbursement.

2 Earmarked receipt data entry for conduit committees varies depending on whether the
check was deposited by the conduit before being transmitted to the candidate.

3 Reattributions and Redesignations require multiple transactions to be created. Using the Clon-
ing feature reduces time and effort involved.

4 Credit card payments of operating expenditures use the Endorsement tab to list the vendors.

5 Payroll deduction contributions can be imported, if they are available as a comma delimited
text file. Otherwise, the cloning feature can save time and effort.

6 Exempt legal and accounting fees are entered as Memo entries on Line 11a.

7 Partnerships are entered using the Endorsements tab to list the partners and  their individual
shares of the total contribution.
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�6 Filing Your Report

When all transactions have been entered for a given report, and the deadline for reporting is draw-
ing near, it is a good time to take inventory of the pieces of the reporting puzzle that must be
assembled in order to file electronically.

� You must have your FEC electronic filing password. Without this, you cannot file.
Call the FEC electronic filing office if you do not have or cannot remember your pass
word.

� You must have a modem or a network connection to the Internet. (Unless you intend to
file via diskette).

� Your report must pass validation.

Signing and Dating the Report

If the report is not prop-
erly signed and dated, it
will generate Level 12
errors in the validator,
and uploading will not
be possible. If you are
not ready to actually
upload the report, but
want to validate it, you
may want to leave the
report date blank. If you
enter the report date, the
report will be locked
and no further data en-
try will be allowed un-
til the date is removed.

� To “sign”
and date the report,
select File Report
from the edit menu.

This can be done with
any View active (fig. 1).  The date range of the report will be grayed out and cannot be changed.

fig. 1
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This information was entered when the report was created. The election information is only avail-
able for pre- and post-election reports.

� Enter the actual date the report will be filed in the Filed on field.

� The Filing ID is only used for amendments, and should be blank for new reports. For amended
reports, enter the filing number of the report being amended.

� In the Signed by list,
select the treasurer or
assistant treasurer who
will “sign” the report.
This may have been
done earlier when the
report was created. If
not, select the correct in-
dividual from the list or
add them by right click-
ing in the list box.

� On the Special tab,
check all boxes that ap-
ply (fig. 2). If the com-
mittee files form 3x, all
of the boxes will be
available. If not, the
multi candidate box will
be grayed out.

  Validation

The validation process looks for errors and omissions in your report. It does not evaluate your filing
for correct reporting practices, but it will alert you to missing information, such as employers and
occupations, or failure to designate a signatory for the report.

� To validate your report,  select Validator from the View menu or click on the Validator button
on the toolbar. See Chapter 3 for detailed information on the validator report. Once the errors
reported by the validator have been rectified, you are ready to upload the report.

  Uploading the Report

To begin the upload process:

� Choose Upload from the File menu, or click on the Upload button on the tool bar.

fig. 2
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� If your report has not been validated, the upload process automatically runs  the validator.

� If errors are found that are level 8 or higher, you will not be allowed to upload the report.

� If errors are found that
are below level 8, you will
receive a warning on the
screen that notifies you of
the errors and asks if you
wish to continue. It is advis-
able to correct as many of
the errors as possible before
filing.

� If no errors are found, or
you indicate that you wish
to file the report with errors,
the Upload Settings screen
appears (fig. 3).

Password

The Password is required
and must be obtained from
the FEC electronic filing
office. (See Appendix I)

ID

The ID is your committee ID which should already be in the system. If not, enter your 9 digit
committee ID (the one that starts with “C00”).

Fax and E-mail

A Fax number and/or Email address  is  required. This is how you will receive the confirmation that
the report has been received by the FEC. If you enter both, you will receive both.

Filing Method

TCP/IP

This option sends your report to the Commission via the Internet.  This is the simplest way to send
the report if you are connected to the Internet and have no security measures in place that would
prevent you from uploading via the Internet.  The configure tab has information the software uses
to communicate with the FEC electronic filing system. The TCP/IP host name should be
fecef1.sdrdc.com (all lower case), and the Agency ID should be FEC (all upper case). The software

fig. 3
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defaults to these settings. If they are changed, they must be reset to the defaults in order to upload
the report.

Dialup

The Dialup option utilizes
a direct modem-to -modem
communication between
your computer and the FEC
electronic filing system. It
is slightly less convenient
than TCP/IP because it re-
quires some special infor-
mation on the configuration
tab (fig. 4)  that may not be
readily available. This op-
tion can be used for filers
who have no Internet con-
nection or those who have
special firewall or proxy
server restrictions against
uploading files via the
Internet.

COM port
The Com port setting de-
faults to port 2. This is the
most common port used by
modems. If your modem
does not use com port 2,
change to the correct com
port.

Baud rate
The default Baud rate is
19200. This is an indication
of the speed with which the
modem transfers data.  You
can set this to match your
connection speed but do not
set it higher.

Dialup string
The Dialup string is a series
of letters followed by a
phone number.  This infor-
mation is passed to your

fig. 3

fig. 4
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modem to enable it to connect with the FEC modem pool.

Agency ID
This information is used to direct the filing to the proper part of the electronic filing system.

Diskette (A: or B:)

If, for whatever reason, the Internet or a phone line is not available, the reports may be submitted on
diskette. Insert a blank diskette in the diskette drive and select A: or B:, whichever one is correct for
your computer. Choose OK. The Diskette should be mailed along with a signed summary page to
the FEC. Diskette filings require an actual signed summary page because there is no way to trans-
mit the password via diskette.

NOTE: Diskette filings are subject to the same deadlines as paper filings!

During the Filing Process

When you choose OK, the file is uploaded to the FEC electronic filing server. On your screen you
will see a series of messages telling you what is happening. If at any point during the process,
something is found to be incorrect, the process will be terminated and the word FAILED will
appear at the bottom of the screen.  The most common failures are incorrect passwords (The pass-
word IS case sensitive) and uploading without first connecting to the Internet (TCP/IP only) . If the
upload process generates a FAILED message at any point, call Tech Support.

If the password is correct, and there are no other reasons to reject the file (the Validator usually
eliminates most other problems), the last line of the message is Succeeded. At this point you know
that your file has been received by the FEC. This does not mean that the file has been accepted! If
the file is accepted, you will receive a fax or email within a few minutes notifying you that the filing
was accepted. If you don’t receive this notification, you should call the electronic filing office
immediately.
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When you receive your notification you will recognize it as the same printout that the validator
provided. It should in fact be nearly identical. The MD5 Checksum number should match exactly.

Example:

The only difference between this notification and the one you print out from the validator is the
addition of a block of information about filing date and time and a Filing ID number. This number
is assigned when the report is received and it is important. If you find that you must amend this
report, you must provide the Filing ID of the report.  Once you know the Filing ID, you should
choose File Report from the Edit menu. Enter the Filing ID in the Filing ID field. By following this
procedure, the Filing ID will be in place if it is ever needed.

NOTE:  The Faxed or emailed receipt is your official receipt and should be kept just
as you would keep a certified mail receipt. This is proof that you filed your report.

Review - Chapter 6

1 Password! You must have a password to file electronically.

2 You must “sign” the report by indicating  the treasurer or assistant treasurer.

3 Entering a Filed on date is required prior to filing, but doing so does not upload your report to
the FEC!

4 Reports may be uploaded via the Internet or by direct modem connection.

5 When a report is uploaded and accepted by the FEC, you will receive a fax or email confirma-
tion. If you do not receive the confirmation, call the FEC electronic filing office!
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There are two types of reports produced by FECFile that are related to the Form 3 and Form 3x
reports.  An amended report is based on a previously filed report and a 48-hour notice is a special
report that contains information that will be reported on the next Form 3/3x report filed. In FECFile,
both require that a current or previous report be available on the Reports View. Little additional
data entry is required for these reports, as the bulk of the information is often already entered.

Amendments

ONLY ELECTRONICALLY FILED REPORTS CAN BE AMENDED ELECTRONI-
CALLY!

If the report you are amending was originally filed on paper, you cannot file your amendment
electronically.

When you filed your original report electronically, you received a faxed or emailed confirmation
from the FEC that included a Filing ID number. The Filing ID is in the format “FEC-XXXX”
where the Xs represent numbers. You will need this number when filing an amendment.

Creating an amendment

� Go to View, and Reports.

� Right click on the report you wish to amend and choose Amend. The report screen
that opens should already have most of the correct information.

� If the treasurer’s name is being changed as part of the amendment, change it here.

� If the Filing ID field is empty, enter the Filing ID of the report being amended.

� Choose OK to create the amended report.

Now you should have a new report on your Reports View. The new report should be the same as the
original except the name of the report has been changed form “N” to “AC” to indicate and amended
report.

Modifying transactions for the amendment

Transactions that were incorrectly reported in the original report can now be corrected.

� Go to the view that contains the incorrect transaction (e.g. Receipts, Disbursements),
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�7 Amendments and 48-hour notices
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and find the transaction you wish to edit.

� Right click on it and choose Correction.

� In the Item Information screen, make the necessary changes to the transaction. Choose
OK. Notice that the original transaction is marked out but can be seen for reference
purposes.

Adding new transactions for the amendment

Adding new transactions to an amended report is the same as adding new transactions to an original
report. Go to the Summary Page View and double click on the line that represents the new transac-
tion. Enter the data as per the instructions in chapter 4.

Deleting transactions from an amended report

To delete a transaction from an amended report, go to the view that displays the transaction, single
click on the transaction, and choose Delete from the Edit menu.

Filing an amended report

An amended report is filed like a new report - with one exception. The Filing ID must be entered
into the Filing ID field on the Upload screen (choose Upload from the File menu). This is the
number that was emailed or faxed to you on your filing confirmation from the original filing.
Without this number, you will not be allowed to upload your file.

Previewing amended reports

By choosing Preview from the File menu, or choosing the Preview button on the control bar, you
can preview your amended report just as you would preview an original report -- with one impor-
tant difference. While the default setting is to preview the entire report, you may also choose to
view only the amended items by selecting Amended only from the View menu. This is only avail-
able while previewing an amended report. You will  see a large “C” for changed transactions and an
“A” for added ones. When the file is uploaded, it includes all transactions, not just altered or new
ones.

48-Hour Notices (Form 6)

Only candidate committees report a Form 6 to the FEC.  If you are filing Form3 electronically, you
will have the option to select 48-Hour Notice (Form 6) from the Reports View.  If you are filing
using Form3X you will not have this report type available to you since it is not applicable.

To create a 48-Hour Notice (Form 6)

The transactions that are reported on a Form 6 are also reported on the next scheduled report.  For
example, Vicky Haskell contributed $1,000 to your committee on October 25, 2000.  You enter this
contribution in the January 31 Year-End report (YE) which, in your situation, covers 10/1/00 through
12/31/00 (these dates are just an example).  The contribution from Vicky will be reported in your
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total individual contributions on this report.  In addition, the FEC requires you to submit a 48-hour
notice for this contribution since it is $1,000 or more and it was received within 20 days of the
election.

In FECFile,  transactions are not created on Form 6. All transactions that are reported on Form 6 are
created on Form 3. Enter all such contributions in FECFile by selecting the correct Form 3 report
from the Reports View.  Select   the Summery page View, and add the transactions by double
clicking on the correct line as described in Chapter 4.

Create the 48-Hour Notice:

1. Open the Reports View.

2. Choose Edit and New.

3. Select 48-Hour Notice (Form 6) from the report type list.  This will be the last report
type on the list.  Enter the information on the Details tab (i.e., State - this is the state where the
committee is registered; Date - date of the election; Signed by - select the name of the individual
from the drop down list who will be signing this report).

4. Highlight the report (defined as F6 in the type column) from the Reports View.

5. Go to the Receipts View and select the contribution that should appear on the 48-hour
notice (in the example above, Vicky Haskell on 10/25/00 for $1,000).  Click the transaction
once so it is highlighted.

6. Go to Edit on the menu bar and select Clone.  You have the ability to change any of the
information about the transaction.  However, all the information should be the same.  Notice the
Memo box has a check mark.  It is important to record these transactions as Memo items so that
your committee’s total contributions are not inflated.  Remember, the receipt will also be sub-
mitted in the next report (January 31 Year-End report in the example given above.)

7. Repeat steps 4 and 5 for each transaction to be reported.

Delete - If you selected a transaction to be sent to the 48-hour notice erroneously, the transaction
can be deleted.  Find the transaction in the Receipts View.  These transactions will have Memo in
the Line# column and N/A in the YTD column.  Highlight the transaction.  Go to Edit on the menu
bar and select Delete.  Click Yes when you are asked if you are sure you want to delete the transac-
tion.  (This will not delete the contribution from the Form 3  report. It will only be removed from the
48-hour notice).

Modify - You can modify a transaction that was sent to the 48-hour notice.  Find the transaction in
the Receipts View.  These transactions will have Memo in the Line# column and N/A in the YTD
column.

� Highlight the transaction.

� Go to Edit on the menu bar and select Modify.

� Make the necessary changes.

� Click Yes when you are asked if you are sure you want to replace the transaction.  (This
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will not modify the contribution from the Form 3 report. It will only be  modified in the 48-hour
notice.) To modify the original transaction, select the correct Form 3 report from the Reports
View. Select the correct view for the transaction (Receipts, Disbursements, etc.), find the trans-
action and edit it. The original transaction will not be marked as a Memo.

Review - Chapter 7

1 Only electronically filed reports may be amended electronically.

2 Amended reports require the filing number of the original report.

3 Forty-Eight Hour Notices can only be created from an existing Form 3 report.

4 Amendments and 48-hour notices are uploaded just like any other report.
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�8 Importing Data

Many people use computers to maintain information regarding receipts
and disbursements related to running a campaign, PAC or party, even
though reports filed with the FEC are completed by hand.  If this is the
case for your committee, you may be able to import your transactions
from all previous reports in the current year so that your individual aggre-
gates and calendar-to-date figures will be correct (see Chapter 2 ). Even if
you begin electronic filing with your first report of the year, the ability to
import names and addresses from previous reports can save a great deal of
time and effort. An import routine has been included with the FECFile

program that in many cases will allow the user to bring information from other programs into
FECFile. If  the number of previous transactions is small, it may be better to enter it into the system
manually. This gives the user the opportunity to learn the software while actually preparing a re-
port. If the data entry would be too extensive, it may be best to import it.

NOTE: Only schedule A and schedule B may be imported into FECFile. This includes all lines for
these schedules. Schedules C, D, E, F and H must be entered manually.

Preparing an Import File

Contributions and disbursements must be imported separately, and cannot be included  in the same
import file.  Before being imported into FECFile, data must be placed in a flat file, comma delim-
ited format. This may be done easily from many software packages, including spread sheet, data
base, and committee management programs.  In many such programs the data may be saved as a
comma delimited file by choosing “Save as” from the file menu, and indicating “Comma Delim-
ited” or “ASCII text”.  Check the help systems or tech support for the software you use for detailed
instructions. For the data to import properly, it must conform to the  format described below.

It is not necessary that every column named below be included in every comma-delimited import
file. Default values are used for  columns that are not included. A  date column, an amount column,
and (at least) a lastname column must always be included.  Contributor type or payee type should
also be included. It is used to determine the proper method of displaying the name of the contribu-
tor or payee. If it is not included, the imported records will be assigned IND (individual).

Schedule A

Name Description
CTRB_TYPE Contribution type
CTRB_DATE Date, in CCYYMMDD format (e.g. 19981231)
CTRB_AMT Amount
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CTRBTR_TYPE Contributor type
CTRBTR_LNAME Contributor last name
CTRBTR_FNAME Contributor first name
CTRBTR_NMPFX Contributor name prefix (e.g. Mr. Ms)
CTRBTR_NMSFX Contributor name suffix (eg. Jr., Sr.)
CTRBTR_ADDR1 Contributor address, line 1
CTRBTR_ADDR2 Contributor address, line 2
CTRBTR_CITY Contributor address, city
CTRBTR_ST Contributor address, State
CTRBTR_ZIP Contributor address, ZIP code
Name Description

CTRBTR_EMP Contributor employer
CTRBTR_OCC Contrbutor occupation
CTRB_ELEC Election-type code
CTRB_ELECD Election date
CTRB_MEMOTEXT Text description related to this contribution

Schedule B

PMNT_TYPE Payment type
PMNT _DATE Date, in CCYYMMDD format (e.g. 19981231)
PMNT _AMT Amount
PMNT_PURP Purpose of this payment
PAYEE_TYPE Payee type (1)
PAYEE_LNAME Payee last name (or organization name)
PAYEE_FNAME Payee first name
PAYEE_NMPFX Payee name prefix (e.g. Mr. Ms)
PAYEE_NMSFX Payee name suffix (eg. Jr., Sr.)
PAYEE_ADDR1 Payee address, line 1
PAYEE_ADDR2 Payee address, line 2
PAYEE_CITY Payee address, city
PAYEE_ST Payee address, State
PAYEE_ZIP Payee, ZIP code
PAYEE_OFF Federal office sought by payee, if candidate
PAYEE_OST State in which office is sought
PAYEE_ODIST District in which office is sought
PMNT_ELEC Election-type code
PMNT_ELECD Election date
PMNT_MEMOTEXT Text description related to this contribution

Contribution types available are:
SA_CTRBI Contribution from an individual (default)
SA_CTRBP Contribution from a Political Party Committee
SA_CTRBA Contribution from other political committee (PAC)
SA_CTRBC Contribution from the Candidate (Form 3 only)
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SA_XFER Transfer from other affiliated committee
SA_OFST Offset to operating expenditure
SA_RFNDRefund of federal contribution made
SA_OTHR Other (dividend, interest, etc.)

Contributor and payee types available are:
??? Unknown
CAN Candidate
CCM Candidate Committee
COM Committee
IND Individual (a person). (default)
ORG Organization (not a committee and not a person)
PAC Political Action Committee
PTY Political Party Organization

Disbursement types available are:
SB_XPNDOperating Expenditure (default)
SB_XFER Transfer to affiliated committee
SB_CTRB Contribution to a candidate
SB_OTHER Other expenditure

Federal Office sought by payee
? Unknown
H House
S Senate
P President/Vice President

All Dates must be in the format, CCYYMMDD (e.g. 1999/12/31 for Dec. 31, 1999).

Examples of import-ready files may be found in the FECFILE3/CSV2DCF3 directory. SCHA.CSV
contains schedule A transactions and SCHB.CSV contains schedule B transactions. You may use
these files as guides when creating your own import files.

Importing

Always Back Up Your File Before Importing!

In order to import the transactions into FECFile, you must have or create a report in FECFile that
covers the date range of the imported data. The report may already exist or you may create a new
one. This is done within FECFile 3 (see Chapter 3 for details). Once you have a file to import and
a report into which to import the file, you are ready to import.  If FECFile is open, close it before
importing.
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� To start the import program, go to Start, Programs, FECFile3 and choose CSV2DCF.

� This will start the import program which is separate from the FECFile program.

� From the File menu, choose Open and select the .dcf file that contains the report into
which you wish to import data.

� Choose the A button or B button from the toolbar to correspond with the type of
transactions in your file.

� Select the file to import and choose Open.

� The file type defaults to CSV. If your file has a different extension, choose All Files
from the file type list. The transactions in file will be imported.

Duplicate Records

During the import process, each
transaction is evaluated in an ef-
fort to ensure that the correct per-
son, or entity, is credited with the
transaction. The name and ad-
dress information is compared
with the names and addresses in
the .dcf file. When an exact match
is found, the transaction is cred-
ited to the existing record. When
a similar record is found, the Fin-
ish Partial Match  screen appears
(fig. 1).

The first column displays infor-
mation about a record that already
exists in the .dcf file. It may have
been present prior to the import,
or it may have been created as the
result of an earlier transaction in
the current import file. The sec-
ond column displays the details
of the new transaction. If you de-
cide the New Item and the Exist-
ing Item represent separate enti-
ties and should not be combined,
choose Continue. If the New Item
represents the same record as the
Existing Item, with perhaps a new
address or a misspelling, choose Merge and the new transaction will be added to the existing record.
If the New Item has information, such as an updated address, that should supercede that in the
existing item, click on the “<<“ button for each piece of information to be updated or click on the

fig.1
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“<<<“ button at the bottom of the screen to replace the Existing Item information with that from the
New Item.

If you have begun making changes on the screen, and wish to undo the changes, click on the Reset
All button.

When the import is finished, go to File and choose Exit. Save the file. When you open FECFile
again, and open the file into which you imported the new data, you will find the information there
when you view the summary page, receipts or disbursements.

Payroll Import

If your committee receives contributions via payroll deduction, and the information is provided to
you in electronic format, it may be possible to import the information on a regular basis into FECFile.
The best option is to have the information formatted correctly by your payroll or accounting office.
If this is not possible, you may be able to make modifications to the file using whatever spreadsheet
or database management software you prefer. See the format descriptions earlier in this chapter for
details. Imported payroll deduction transactions will be entered as separate transactions, as op-
posed to lump sum transactions, but only those that exceed the Calendar-to-date itemization thresh-
old will be reported on line 11a.

Importing Names and Addresses

All importing must be done in relation to schedule A or B. There is no direct name and address
import feature, but by assigning an arbitrary date and amount to the names and addresses, and
importing them as transactions, the desired result can be achieved.  After the import, the transac-
tions can be purged from the system, and only the names and addresses will remain.

Always back up your .DCF file before importing!

� In FECFile 3, create a report to contain the imported transactions.  This must be created
in the file that you will be using for your FEC reports. The dates are arbitrary for this
report and it will be deleted after the import, but it is best to create an older report, such
as a 1990 year-end report.   (1/1/1990 to 12/31/1990)

� Close FECFile 3 and save the file.

� Create a comma delimited file with all the information you want to import. (Refer to the
beginning of this chapter.) This can be a schedule A or a schedule B import file. This
example uses column names for schedule A. Create columns for:

Last name city occupation

First name state date

Address line 1 zip amount

Address line 2 employer contributor type
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� If you do not have information for one of these columns, you may leave it out. If you do
not include contributor type, however, the names may not display properly. Refer to the
Contributor Type list earlier in this chapter. Fill the dates with 19900101 (Jan 1st 1990)
or any other date in the report date range and fill the amount column with zeros.

� Using the CSV2DCF import program, open your .DCF file (the one you are importing
into), and open the import file (the one you created).

� When the import is finished,  close CSV2DCF and save the .DCF file.

� Open FECFile 3 and open the .DCF file into which you imported the names and ad-
dresses. You will see the names and addresses listed in the Individuals and Organiza-
tions View.

Next, remove the transactions and the 1990 report from FECFile 3:

� From the Reports View, right click on the 1990 report and choose File Report (A report
must have a filed on date before it can be purged). Enter 1/1/1991 in the filing date field,
and close the report screen.

� Right click on the 1990 report, and choose Purge.  This will remove all of the “zero”
contributions and delete the 1990 report, leaving behind only the names and addresses
that were imported with them.

Review - Chapter 8

1 Transactions for Schedule A and Schedule B can be imported.

2 The import file must be in a comma delimited format.

3     Most spreadsheet and database software can produce comma delimited files.

4 The column headers must be correct in the import file.

5 Potential duplicate records are automatically displayed. You make the determination whether
they are actual duplicates, or just similar records, and the transactions are imported accord-
ingly.

6     Names and addresses can be imported by treating them like transactions.
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��I   Password Request Letter

This is a sample password request letter. It should be written  on official committee letterhead and be
signed by those for whom a password is requested. Fax the request to 202-219-0674. For assis-
tance, call 202-694-1293.

* * * * * * * * * * * *

[DATE]

Federal Election Commission
Attention:  Electronic Filing Office, Room 428

This document serves as an official password request for the purpose of filing electronic reports
for [ENTER YOUR COMMITTEE NAME]. The FEC-assigned, 9-digit Committee ID for this
Committee is [ENTER YOUR COMMITTEE ID (e.g., C98123456)].

You may contact me at [ENTER YOUR VOICE PHONE HERE].

I represent that I have the authority to sign FEC reports for the above named committee.

Sincerely,

___________________________________ ___________________________________
[PRINT TREASURER’S NAME] [TREASURER’S SIGNATURE]

___________________________________ ______________________________
[PRINT ASSISTANT TREASURER’S NAME             [ASSISTANT TREASURER’S
(IF APPLICABLE)]  SIGNATURE (IF APPLICABLE)]
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�II Frequently Asked Questions

The following is a list of answers to  the most frequently questions received by the technical sup-
port staff.  the questions are divided into categories to make it easier to find the situation you are
looking for.

Filing reports:

Q: What is the deadline for filing an electronic report?

A: Electronically filed reports are due BEFORE midnight of the filing deadline day. The files
are considered to be received when they have been entirely uploaded to the FEC. This means
that if you begin the upload process one minute before midnight, and it is completed one minute
after midnight, it has NOT been filed on time and is considered late.

Q: Should I file on paper as well as electronically?

A: No.  Please file only electronically.

Q: Can I email my filing to the FEC?

A: No. The file must be uploaded following the procedures outlined in this manual.

Q: How do I know the FEC has my filing?

A: You will receive a confirming  fax, email or both within a few minutes of filing your report.

Q: If I am required to send a document such as a signed loan instrument from a bank, how do I send
it?

A: In cases such as these where actual documents are required, you must send them to the FEC
by conventional means. While they must be delivered promptly, they are not subject to the
same deadline as the electronic filing and would not be considered late if they are received
promptly. They will be scanned and displayed with the filing on the FEC website.

Q: What do I do if I forget my password?

A: Your password is private, and thus the FEC cannot look it up for you. If you forget your
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password, you must request a new one following the same procedures as for the original pass-
word. See Appendix 1 for a sample password request letter.

Q: If I upload a report and do not receive a faxed or emailed confirmation, what should I do?

A: All successfully filed reports should generate a fax or email or both to confirm that the file
has been received and accepted by the FEC electronic filing system. If you do not receive this
confirmation, it means one of three things:

1 The upload process was not completed. If this is the case, there will be an on-screen
message stating that the upload process failed and indicating the reason, such as a bad
password or lost Internet connection. Even though the information is presented on the screen,
it is sometimes not read carefully by the filer who assumes the filing went through. Pay
attention to the messages! These problems are usually easy to deal with.

2 The upload process was completed but, the filing was rejected by the electronic filing
system. If this happens, there will be a clear message on the screen indicating why the file
was rejected. Again, pay attention to the messages on the screen during the upload process.
Make the necessary changes to the file and upload it again.

3 The upload process was completed and the file was accepted, but no email or fax was
received. In this case, the culprit is usually an email or faxline problem at the receiving end.

In any of these cases, if you did not receive confirmation, you should assume that your filing was
not completed properly. You can check the FEC website, www.fec.gov, to see if your filing is
there. It should be there within a few minutes of filing in most cases. Even if it is there, CALL THE
FEC ELECTRONIC FILING OFFICE! The confirmation is your actual receipt for filing, and you
must receive it. If the filing was not properly uploaded, we can help you figure out why so you can
upload the file. If it was properly uploaded, we can issue you a fax or email receipt manually.

Data Entry

Q: How do I force a transaction to itemize if it is below the itemization threshold?

A: Single click on the transaction in the appropriate view and choose Itemize from the Edit
menu. This will force an unitemized transaction to be treated as an itemized one. This menu
choice toggles, so if you select it again, it returns the transaction to unitemized status.

Q: How do I enter outstanding debts from previous years?

A: You must create separate reports to cover those years. Enter the original debts or loans on
the correct dates. Payments prior to the current year may be made as a single lump sum payment
in the same report as the debt is entered. See Chapter 2 for details.
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Q: How do I enter Loan or Debt repayments?

A: Loan and Debt repayments are among the few transactions that are not created through the
Summary page View. To enter a repayment, you must already have created the Loan or Debt by
clicking on the correct line of the Summary page View line.  Choose the Obligations View and
right click on the debt or loan that  is  being repayed. Choose Repayment from the menu. (This
can also be done by choosing Repayment from the Edit menu.) This will create a payment that
is linked to the original obligation, so that schedule C or D will report the correct outstanding
balance.

Q: Can I import my schedules regarding loans, debts or shared allocable activities (Schedule H?)

A: No. The CSV2DCF Import program only applies to Schedules A and B. No other schedule
can be imported.

Q: I chose the wrong report type when I set up my report. How can I change it?

A: Unfortunately you can’t change a report type. Try calling Tech Support; they may be able to
change it for you.

Previewing and Printing

Q: Can I print a list of contributors from the software?

A: No lists can be printed directly from the software. Only the FEC  report can be printed.

Q: Why, in the preview, do I not see all the contributions I have entered?

A: The preview will only list Itemized activities.

Q: When previewing an amended report, can I preview amended items only ?

A: Yes. When previewing, choose Amended Only from the View menu.

General

Q: Can I see a list of all the contributions I have entered?

A: A list of contributions as well as disbursements and obligations can be viewed in the soft-
ware by selecting the appropriate View from the View menu.

Q: How can I search for existing people or transactions in FECFile 3?

A: There is no search function in FECFile 3. You can, however, sort the columns of the Views
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by clicking on the column header of the column you wish to sort. Clicking the same header
again reverses the sort order.

Q: Can I get my own password?

A: If you are on record at the FEC as the official Treasurer or Assistant Treasurer for your
committee, you can get a password.

Q: Can FECFile 3 be set up on a network for multiple users?

A: No. FECFile 3 must be installed on a local hard drive.

Q: Can I use FECFile 3 on a MAC?

A: No. FECFile 3 requires a Windows 95 or higher or NT 4.0 or higher operating system.
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�III   Troubleshooting

When the program does not appear to be functioning correctly, and you believe you are following
the proper procedures, look at the list below.  This list of problems or apparent problems was
compiled from the technical support logs and represents the most commonly encountered prob-
lems.

Problem

The Summary View is blank.

The YTD aggregate is incor-
rect for a contributor.

The validator complains of a
line that is too long.

New report does not contain
old data.

Cannot edit old data.

Cause

No report is selected.

There may be multiple
records for the contributor
instead of a single record
with multiple contributions.

Each piece of information is
limited to a specific length.
For example, the purpose of
disbursement is limited to
100 characters. This usually
occurs when data is im-
ported.

The new report was created
in a new file.

Reports are locked when a
filing date is stamped on
them.

Solution

Select your report from the
Reports View.

Delete the transactions from
one of the records and delete
the record. Add the transactions
to the remaining record.

Select the View that displays
the entry cited in the validator
error message, open the entry
that contains the line and ab-
breviate it.

Do not go to File and New to
create a new report. Go to the
Reports View and choose Edit
and New Report.

If the report has been uploaded
to the FEC, don't make
changes. If it has not, right click
on the report that includes the
transactions that are locked,
and choose File Report. Delete
the Filed on date.
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Problem

Won’t accept Filed on date.

Won’t accept transaction date.

48-hour report not on reports
list.

Lookup table missing com-
mittees.

Cause

The Filed on date must be
after the last day of the re-
porting period.

The transaction date is out-
side of the report date range.

Wrong report type.

Table is out of date.

Solution

Change Filed on date and file
after the close of the period

Make sure you are entering the
transaction in the correct report.
Memo items may have dates
outside of the report range.

Only Form 3 can generate a 48-
hour report.

Choose File, Download. (Con-
nect to the Internet first unless
using a modem connection.)
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�IV   Validator Errors

There is a long list of possible error codes that can be displayed in the validator. Most of these do
not apply to FECFile, but are necessary to provide information to other programmers who sup-
port electronic filing. To correct an error, go to the transaction indicated by the error message,
and make the necessary changes.

Level 16 errors will prevent a report from uploading. None of these errors can be caused by user
error and, if you receive any of them (unlikely), you should contact the FEC electronic filing
office.

Lvl  Message
—  ————————————————————————————————————-
16   FormName  Fld# 001  Unrecognized Form Type / Record Ignored
16   FormName  Fld# ___  Missing Cover Form (eg. F3A, F3XN, ...)
16   FormName  Fld# 002  ID# _________ NOT Correct FEC Format
16   FormName  Fld# 002  ID# _________ NOT SAME AS Cover Page ID#
16   FormName  Fld# 001  Schedule does not belong with Form ____
16   Filing not Verifiable!  Header missing/incomplete.

16   Filing not Accepted!  Schedule Counts inconsistent.

Level 12 errors are serious enough to prevent a file from uploading. Most of them do not apply to
FECFile. Those that do are in bold text.

Lvl  Message
—  ————————————————————————————————————-

12   FormName  Fld# ___  Report Type is Missing or Invalid
12   FormName  Fld# ___  exceeds maximum length of

(This is most often the result of importing data)
12   FormName  Fld# ___  is Required, but field is Empty

(Usually the Treasurer’s name or Filing Date)
12   FormName  Fld# ___  Multi-Form Filings are NOT Allowed
12   FormName  Fld# ___  Schedule H3(s) not Version 2.02 format
12   FormName  Fld# ___  Extraneous data follows last field

12   FormName  Fld# ___  Extraneous data coded in a Dummy field

Level 8 errors will prevent a report from uploading. Correct them if possible. Level 8 errors are
not likely to be encountered by FECFile users.

Lvl  Message
—  ————————————————————————————————————-
08   FormName  Fld# ___  Embedded double-quotes (“) not allowed
08   FormName  Fld# ___  Leading Blanks {e.g.“ TEXT”} not allowed



Appendix IV Page 93

08   FormName  Fld# ___  Bad Date - ________ not YYYYMMDD format
                           “   “         “    “  CCYYMMDD   “
                           “   “         “    “  MMDDYYYY   “
                           “   “         “    “  MMDDCCYY   “
08   FormName  Fld# ___  Not a Real Date or Outside 1960-2099
08   FormName  Fld# ___  Invalid Amount format:
08   FormName  Fld# ___  Non-numeric data in Numeric Field
08   FormName  Fld# ___  ____ is an Invalid Year (CCYY) Format
08   FormName  Fld# ___  Invalid Rate format: _____
08   FormName  Fld# ___  Wrong Report Type for this Form
08  (Deleted)  Fld# ___  Non-numeric Sequence/Reference Number
08   FormName  Fld# ___  District “__” is not 2-digit Numeric format

08   FormName  Fld# ___  Amended Code must be A,C,D,N - not “_”
08   FormName  Fld# ___  Only Amended Code “A” allowed on New filings
08   FormName  Fld# ___  Tran ID is NOT UNIQUE - This one is same as other(s)
08   FormName  Fld# ___  Cannot Amend Transaction(s) within this filing
08   FormName  Fld# ___  Back-Reference TRAN-ID does not match Sched TRAN-ID
08   FormName  Fld# ___  Event MUST be identified as [D]irect or [E]xempt

Level 4 errors will not cause a filing to be rejected. They should, however, be corrected to the
extent possible. Those most likely to be encountered by FECFile users are listed in bold text.

Lvl  Message
—  ————————————————————————————————————-
04   Lost or Altered Data!  Control Numbers don’t match.
04   FormName  Fld# ___  Conditionally Required field is Empty
04   FormName  Fld# ___  Subtotal {__________} not supported by other lines
04   FormName  Fld# ___  Subtotal {__________} not supported by Schedule ___

04   FormName  Fld# ___  Prim/Gen/Other code invalid:
04   FormName  Fld# ___  Street Address is Missing
04   FormName  Fld# ___  Single-line Address NOT in 1st delimited field
04   FormName  Fld# ___  __ not a valid 2-character USPS State Code
04   FormName  Fld# ___  Zip Code is Invalid or Missing / Zip =
04   FormName  Fld# ___  Invalid Area Code/Phone Number:
04   FormName  Fld# ___  Office Code “_” Invalid
04   FormName  Fld# ___  Comm Code “__” Invalid.
04   FormName  Fld# ___  Comm Target “_” Invalid.
04   FormName  Fld# ___  Ratio Code “_” Invalid
04   FormName  Fld# ___  Sup/Opp Code “___” Invalid
04   FormName  Fld# ___  Committee Type “_” is Invalid for this form
04   FormName  Fld# ___  ___ not a valid 3-character Party Code
04   FormName  Fld# ___  ___ not a valid Party Type (NAT,STA,SUB)
04   FormName  Fld# ___  ___ Invalid Creditor (ICV,UCV,CAN,EMP,OTH)
04   FormName  Fld# ___  ___ not a Valid Itemized Transaction
04   FormName  Fld# ___  Value “_” is Invalid for this Yes/No field
04   FormName  Fld# ___  Value “_” is Invalid for “Check-box=X” field
04   FormName  Fld# ___  Point Value Subtotal is INCORRECT     (Sch H1)
04   FormName  Fld# ___  Schedule contains Redundant Sections  (Sch H1)
04   FormName  Fld# ___  Name has Too Many Parts (Over 3 Delimiters Found)
04   FormName  Fld# ___  Entity Type [___] is not an acceptable value

04   FormName  Fld# ___  Delimited Name should not exceed 38 letters & spaces
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